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Copyrights and Trademark Notices
Copyright © 2020 Telestream, LLC. All rights reserved worldwide. No part of this 
publication may be reproduced, transmitted, transcribed, altered, or translated into any 
languages without the written permission of Telestream. Information and 
specifications in this document are subject to change without notice and do not 
represent a commitment on the part of Telestream.

Telestream. Telestream, CaptionMaker, Cerify, Episode, Flip4Mac, FlipFactory, Flip 
Player, Gameshow, GraphicsFactory, Lightspeed, MetaFlip, Post Producer, Prism, 
ScreenFlow, Split-and-Stitch, Switch, Tempo, TrafficManager, Vantage, VOD Producer, 
and Wirecast are registered trademarks and Aurora, Cricket, e-Captioning, Inspector, iQ, 
iVMS, iVMS ASM, MacCaption, Pipeline, Sentry, Surveyor, Vantage Cloud Port, 
CaptureVU, Cerify, FlexVU, Prism, Sentry, Stay Genlock, Aurora, and Vidchecker are 
trademarks of Telestream, LLC and its Affiliates. All other trademarks are the property of 
their respective owners.

Adobe. Adobe® HTTP Dynamic Streaming Copyright © 2014 Adobe Systems. All rights reserved.

Apple. QuickTime, MacOS X, and Safari are trademarks of Apple, Inc. Bonjour, the Bonjour 
logo, and the Bonjour symbol are trademarks of Apple, Inc.
Avid. Portions of this product Copyright 2012 Avid Technology, Inc.
BlackArrow. BlackArrow is a trademark of BlackArrow, Inc.
Canoe. Canoe is a registered trademark of Canoe Ventures, LLC.
Dolby. Dolby and the double-D symbol are registered trademarks of Dolby Laboratories.
Fraunhofer IIS and Thomson Multimedia. MPEG Layer-3 audio coding technology 
licensed from Fraunhofer IIS and Thomson Multimedia.
Google. VP6 and VP8 Copyright Google Inc. 2014 All rights Reserved.
MainConcept. MainConcept is a registered trademark of MainConcept LLC and 
MainConcept AG. Copyright 2004 MainConcept Multimedia Technologies.
Manzanita. Manzanita is a registered trademark of Manzanita Systems, Inc.
MCW. HEVC Decoding software licensed from MCW.
MediaInfo. Copyright © 2002-2013 MediaArea.net SARL. All rights reserved. 
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Microsoft. Microsoft, Windows NT|2000|XP|XP Professional|Server 2003|Server 2008 
|Server 2012, Windows 7, Windows 8, Media Player, Media Encoder, .Net, Internet 
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Explorer, SQL Server 2005|2008|Server 2012, and Windows Media Technologies are 
trademarks of Microsoft Corporation.
SharpSSH2. SharpSSH2 Copyright (c) 2008, Ryan Faircloth. All rights reserved. 
Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:
Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer.
Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.
Neither the name of Diversified Sales and Service, Inc. nor the names of its contributors 
may be used to endorse or promote products derived from this software without 
specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Telerik. RadControls for ASP.NET AJAX copyright Telerik All rights reserved.
VoiceAge. This product is manufactured by Telestream under license from VoiceAge 
Corporation.
x264 LLC. The product is manufactured by Telestream under license from x264 LLC.
Xceed. The Software is Copyright ©1994-2012 Xceed Software Inc., all rights reserved.
ZLIB. Copyright (C) 1995-2013 Jean-loup Gailly and Mark Adler.

Other brands, product names, and company names are trademarks of their respective 
holders, and are used for identification purpose only. 
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MPEG Disclaimers

MPEGLA MPEG2 Patent
ANY USE OF THIS PRODUCT IN ANY MANNER OTHER THAN PERSONAL USE THAT 
COMPLIES WITH THE MPEG-2 STANDARD FOR ENCODING VIDEO INFORMATION FOR 
PACKAGED MEDIA IS EXPRESSLY PROHIBITED WITHOUT A LICENSE UNDER APPLICABLE 
PATENTS IN THE MPEG-2 PATENT PORTFOLIO, WHICH LICENSE IS AVAILABLE FROM 
MPEG LA, LLC, 4600 S. Ulster Street, Suite 400, Denver, Colorado 80237 U.S.A.

MPEGLA MPEG4 VISUAL
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO LICENSE 
FOR THE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER FOR (i) ENCODING 
VIDEO IN COMPLIANCE WITH THE MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO”) AND/
OR (ii) DECODING MPEG-4 VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A 
PERSONAL AND NON-COMMERCIAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO 
PROVIDER LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. 
ADDITIONAL INFORMATION INCLUDING THAT RELATING TO PROMOTIONAL, INTERNAL 
AND COMMERCIAL USES AND LICENSING MAY BE OBTAINED FROM MPEG LA, LLC. SEE 
HTTP://WWW.MPEGLA.COM.

MPEGLA AVC
THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE 
PERSONAL USE OF A CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE 
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD 
(“AVC VIDEO”) AND/OR (ii) DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER 
ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER 
LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR 
ANY OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C. 
SEE HTTP://WWW.MPEGLA.COM.

MPEG4 SYSTEMS
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 SYSTEMS PATENT PORTFOLIO LICENSE 
FOR ENCODING IN COMPLIANCE WITH THE MPEG-4 SYSTEMS STANDARD, EXCEPT THAT 
AN ADDITIONAL LICENSE AND PAYMENT OF ROYALTIES ARE NECESSARY FOR 
ENCODING IN CONNECTION WITH (i) DATA STORED OR REPLICATED IN PHYSICAL MEDIA 
WHICH IS PAID FOR ON A TITLE BY TITLE BASIS AND/OR (ii) DATA WHICH IS PAID FOR ON 
A TITLE BY TITLE BASIS AND IS TRANSMITTED TO AN END USER FOR PERMANENT 
STORAGE AND/OR USE. SUCH ADDITIONAL LICENSE MAY BE OBTAINED FROM MPEG LA, 
LLC. SEE HTTP://WWW.MPEGLA.COM FOR ADDITIONAL DETAILS.
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Limited Warranty and Disclaimers
Telestream, LLC (the Company) warrants to the original registered end user that the 
product will perform as stated below for a period of one (1) year from the date of 
shipment from factory:

Hardware and Media—The Product hardware components, if any, including equipment 
supplied but not manufactured by the Company but NOT including any third party 
equipment that has been substituted by the Distributor for such equipment (the 
“Hardware”), will be free from defects in materials and workmanship under normal 
operating conditions and use.

Warranty Remedies
Your sole remedies under this limited warranty are as follows:

Hardware and Media—The Company will either repair or replace (at its option) any 
defective Hardware component or part, or Software Media, with new or like new 
Hardware components or Software Media. Components may not be necessarily the 
same, but will be of equivalent operation and quality. 

Software Updates
Except as may be provided in a separate agreement between Telestream and You, if 
any, Telestream is under no obligation to maintain or support the Software and 
Telestream has no obligation to furnish you with any further assistance, technical 
support, documentation, software, update, upgrades, or information of any nature or 
kind.

Restrictions and Conditions of Limited Warranty
This Limited Warranty will be void and of no force and effect if (i) Product Hardware or 
Software Media, or any part thereof, is damaged due to abuse, misuse, alteration, 
neglect, or shipping, or as a result of service or modification by a party other than the 
Company, or (ii) Software is modified without the written consent of the Company.

Limitations of Warranties
THE EXPRESS WARRANTIES SET FORTH IN THIS AGREEMENT ARE IN LIEU OF ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY 
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. No oral 
or written information or advice given by the Company, its distributors, dealers or 
agents, shall increase the scope of this Limited Warranty or create any new warranties.

Geographical Limitation of Warranty—This limited warranty is valid only within the 
country in which the Product is purchased/licensed.
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Limitations on Remedies—YOUR EXCLUSIVE REMEDIES, AND THE ENTIRE LIABILITY OF 
Telestream, LLC WITH RESPECT TO THE PRODUCT, SHALL BE AS STATED IN THIS LIMITED 
WARRANTY. Your sole and exclusive remedy for any and all breaches of any Limited 
Warranty by the Company shall be the recovery of reasonable damages which, in the 
aggregate, shall not exceed the total amount of the combined license fee and purchase 
price paid by you for the Product. 

Damages
Telestream, LLC SHALL NOT BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY 
LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES 
ARISING OUT OF YOUR USE OR INABILITY TO USE THE PRODUCT, OR THE BREACH OF 
ANY EXPRESS OR IMPLIED WARRANTY, EVEN IF THE COMPANY HAS BEEN ADVISED OF 
THE POSSIBILITY OF THOSE DAMAGES, OR ANY REMEDY PROVIDED FAILS OF ITS 
ESSENTIAL PURPOSE.

Further information regarding this limited warranty may be obtained by writing:
Telestream
848 Gold Flat Road
Nevada City, CA 95959 USA

You can call Telestream, LLC. via telephone at (530) 470-1300.
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Introduction to Tempo

This guide provides an overview of Tempo, implemented in Vantage. Use this guide to 
learn how to install and configure Tempo and create Tempo ingest and publication 
workflows. You’ll also learn how to use Tempo Portal to select and segment an asset 
and configure it for re-timing, then submit it to a Tempo publication workflow for 
processing.

Topics
 What Is Tempo?

 How Does Tempo Work?

Note: This guide is written for video professionals who are familiar with Vantage. To 
use Tempo effectively, you should know how to create workflows and submit jobs in 
Vantage, and you should be familiar with the basic operation of Workflow Portal. If you 
aren’t familiar with Vantage, we suggest that you read the Vantage User Guide and 
Vantage Domain Management Guide. If you aren’t familiar with Workflow Portal, 
please read the Using Workflow Portal chapter in the Vantage User Guide.



Introduction to Tempo
What Is Tempo?

12

What Is Tempo?
Vantage™ Tempo™ is a software solution designed specifically for re-timing video 
assets—intelligently decreasing or increasing their running time. Tempo can shorten or 
lengthen an asset’s running time up to ten percent, without noticeable loss of video or 
audio quality.

Using sophisticated time compression algorithms, Tempo can re-time an entire asset or 
specific segments you identify—to deliver superior quality and faster turn-around 
times. Instead of throwing away frames as other technologies do, Tempo intelligently 
interpolates the time change over the content duration, resulting in pristine output 
with no noticeable visible or audible artifacts.

Tempo is implemented using the Telestream Media Framework in Vantage. Tempo 
connects seamlessly to other Vantage or third-party systems to create a powerful 
automated re-timing application—all under unified system control. 
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How Does Tempo Work?
The following topics describe briefly how Tempo works. This information gives you the 
background you need to understand Tempo workflows and to use the Tempo Portal.

Topics
 Tempo Workflows

 Tempo Portal

 Video Processing Details

 Audio Processing

 Captions Processing

 Video Format Support

Tempo Workflows
Tempo is an operator-intervention application. The simplest Tempo applications use 
two media re-timing workflows: an ingest workflow, and a publication workflow. 

The ingest workflow ingests source media, processes it to extract metadata as needed 
for Tempo processing requirements, produces a proxy file and a metadata label, and 
registers all of these resources in a binder in the Vantage catalog for later use. The 
ingest workflow can optionally analyze the source for black and slate/spot/color bars 
segments, as well as scene changes, reducing operator effort by automatically creating 
those segments. 

For each source being re-timed, an operator uses Tempo Portal (described below) to 
scrub the proxy and create or adjust segments, review and edit metadata, configure 
how Tempo should process the asset, and submit it to a publishing workflow for 
processing.

The publishing workflow ingests Tempo processing requirements specified by the 
operator for this asset along with metadata, and adjusts and transcodes the source 
media into a production-ready, re-timed asset for VOD or broadcast.

Alternatively, the Tempo Two Pass feature allows you to process media in multiple 
passes through two workflow stages to achieve very high quality re-timing results. The 
first stage workflow identifies segments that may not respond well to re-timing. You 
can then modify your processing choices for those segments and put the media 
through the second stage publishing workflow. This produces the best possible quality 
in the final output. 

Tempo Portal
In Tempo Portal, an operator selects a binder of media to process, from a catalog of 
assets that have been processed through the ingest workflow. The operator scrubs the 
proxy and creates segments (optionally starting with automatically generated 
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segments) for re-timing; setting segment details and other re-timing options; reviews 
and updates metadata and graphic settings. 

As the operator works, behind the scenes a Composition file is created and updated to 
capture each segment and its processing instructions. Then, the operator forwards the 
asset and processing requirements (via the composition file) to a publishing workflow 
for re-timing during production transcoding.

Video Processing Details
The Composition file auto-generated by Tempo Portal (or programmed externally) 
describes the segmentation of the source program and specifies the re-timing 
parameters to apply to each segment, along with all other required specifications. 
When submitted to a Tempo workflow, the source asset file (also identified in the 
Composition) is processed according to these specifications.

Video re-timing is performed by the Tempo action. In Workflow Designer, the Tempo 
action is part of the Edit group, executed by the Vantage Edit service, which is an 
optional, licensed feature of Vantage.

Note: In Vantage 8.0 UP1 with Tempo ComponentPac 8.0.1 and Vantage 8.0 Tempo 
Update Patch 8.0.345.23, the Tempo action is implemented in Telestream Cloud. Refer 
to the Vantage Cloud Port User Guide for details about using the Tempo action and 
other Vantage actions in Telestream Cloud.

The Tempo action’s processing of a given source asset is guided by the Composition 
that was submitted, along with the Tempo action settings. It transcodes the source 
media from one format to another, re-timing the asset simultaneously, and supplies the 
streams to the Output component.

During audio transcoding, various processing may be applied. Audio may be re-
sampled, or channels may be remapped. For video, filters can also be applied as it is 
being transcoded. The Tempo action includes several common video and audio codecs 
selected using the Transcoder menu.

The Output component you select in the Tempo action specifies the types of media 
files that can be generated 

Tempo begins the re-timing process by analyzing each frame or interpolated frame and 
predicting which can be adjusted for time compensation. Then it applies the re-timing 
over the duration of the content, or to the segments you identify for re-timing. Since 
the entire file (or segment) is analyzed to determine the best candidate frames for 
adjustment, the desired time compression is applied longitudinally rather than at 
random intervals.

The source media file can include one video track and up to 32 audio tracks. 

Timecode propagation is supported in TIFO and QuickTime containers, but not in 
Program Stream or MP4 containers. If you plan to use the general purpose Flip action in 
your workflow, the TIFO format is recommended. 
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Tempo also supports closed captioning, content advisory, Active Format Description, 
and copy generation management (CGMS-A).

The re-timed output video file may be ready for distribution or you can further process 
it with a Flip, Flip64, Multiscreen, or IPTV VOD action for further transcoding and 
packaging into another format prior to distribution. Supported audio and video input 
and output formats are listed on the Tempo data sheet, available on the Telestream 
web site.

Note: Tempo can’t change the fundamental metrics of the video such as frame size or 
frame rate. To do that, create an additional workflow (or transcoding action in the 
same workflow) to convert the re-timed media to your final specifications.

How Segmentation Works
Tempo changes are applied to either the entire duration of an asset or to individual 
segments within the asset, which you can specify. The asset is re-timed according to 
your instructions to create the output file. By default the asset consists of a single 
segment spanning the entire duration of the source. Optionally, black and slate/spot/
color bars segments may be generated automatically, via the segment analysis report.

Operators scrub the proxy, adding new segments and validating auto-generated ones.

Segmentation identifies sections of the file that are eligible or ineligible for changing 
the tempo. A section may be considered ineligible if any of these criteria apply:

• A tempo change is not required (for example, bars, slate, etc.)

• A tempo change is not permissible (for example, barter spots).

• A tempo change would introduce unacceptable artifacts.

Segmentation allows the target file to contain a subset of the source file. This capability 
allows a segment to be excluded (for example, to remove an existing commercial) or 
inserted (such as to replace a texted shot with a textless version).

Segmentation also identifies which sections of the file contribute to the source 
program duration. Tempo changes are then applied to each eligible segment in order 
to achieve the target program duration. Re-timing target percentages can be specified 
separately for specific segments and for the total file. This allows you to limit re-timing 
on sensitive segments or apply greater re-timing to non-crucial segments.

The target program duration may be specified as either an absolute value (such as 
00:30:00;00) or a value relative to the source duration (such as +/- 00:01:00).
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Audio Processing
Tempo performs compression operations on audio with equivalent timing for the 
video. Pitch correction, which is enabled by default, is applied using a special 
synchronous technique that preserves the original sound pitch. You can turn off pitch 
correction for an entire job or segment by segment.

Captions Processing
Caption data (608 and 708) is redistributed to maintain the original presentation times 
without exceeding bandwidth limitations. Tempo also supports captioning in SCC and 
STL files.

Video Format Support
Tempo supports many input and output formats and wrappers. For a list, consult the 
Vantage Transcode encode and decode format sheets on the Telestream.net web site.

http://www.telestream.net/pdfs/datasheets/Vantage_6.3_Format_Encode_Sheets.pdf
http://www.telestream.net/pdfs/datasheets/Vantage_6.3_Format_Decode_Sheets.pdf
http://www.telestream.net
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Configuring Tempo 
Resources

This chapter explains how to configure a Vantage domain to implement a Tempo-
based re-timing application. 

Complete these tasks to get Tempo up and running: 

 Installing Tempo

 Licensing Tempo

 Configuring Tempo

 Creating Tempo Portal Configurations

 Deploying Portals on Client Workstations

When you’ve completed these tasks, create at least two Tempo workflows: an ingest 
workflow and a publication workflow. See Tempo Workflows for examples and 
guidance.

Note: This chapter guides you through the process of creating and configuring the 
required Vantage resources yourself. 

Alternatively, you can download an example set of Tempo resources from the 
Telestream web site. All example workflows are on the Vantage Download page under 
the Workflow Examples tab. Import them into your Vantage domain using the Vantage 
Management Console and customize them to meet your requirements.



Configuring Tempo Resources
Installing Tempo

18

Installing Tempo
Tempo is an optional Vantage feature that can run on Lightspeed servers or other 
servers on which Vantage is installed. For best performance, Telestream recommends 
running Tempo on a Lightspeed K80 server. 

To install Tempo on your Vantage domain server, follow the steps below. 

1. Choose a server that meets the minimum Vantage server specifications listed on 
telestream.net.

2. Install Vantage and any update packs, as described in the Vantage Domain 
Management/Installation Guide. 

3. Install the latest Tempo ComponentPac (if any) from Telestream:

a. Download the latest Tempo package from the Telestream web site: http://
www.telestream.net/telestream-support/tempo/support.htm.

b.  Unzip and copy the ComponentPac file from the package to any local folder for 
single-node domains or a shared folder (using a UNC path or SAN drive letter) for 
Vantage arrays. 

Each Vantage service must be configured with credentials to access shared fold-
ers either by adding credentials in the Vantage Management Console > Settings 
& Options > Authorization tab > Settings & Options—or by using Windows Ser-
vices to configure each Vantage service’s Log On property with a specified 
account. Be sure to restart each service or restart the server when configuration 
is complete.

c. In the Vantage Management Console left column, click ComponentPac 
Management. Installed ComponentPacs display in the Installed ComponentPacs 
list on the right. 

d. Use the Browse button to set the ComponentPac Storage Location field to the 
local or shared folder where you copied the Tempo ComponentPac previously. 

http://www.telestream.net/telestream-support/tempo/support.htm
http://www.telestream.net/telestream-support/tempo/support.htm
http://www.telestream.net/telestream-support/vantage/help.htm
http://www.telestream.net/telestream-support/vantage/help.htm
https://www.telestream.net/vantage/tech-specs.htm
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e. Click Install New Packages. The Install ComponentPacs dialog displays.

 

f. Enable the Tempo ComponentPac you want and click Install.

When installation completes, the Tempo package displays in the Installed Com-
ponentPacs list (as shown in the earlier screen shot).

4. When using Tempo with Vantage Cloud Port, install the latest Tempo Update Patch 
(if any) from Telestream.

5. Locate the Tempo patch Vantage_8_0_Tempo_Update_Patch_Setup(8.0.345.23) and 
run it to update Vantage with the latest Tempo changes.

6. Restart the Tempo service in Management Console > Services panel or restart the 
server.
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Licensing Tempo
If you are adding the Tempo option to an existing Vantage system, obtain the Tempo 
license from Telestream Sales at enterprisesales@telestream.net or call 530-470-1300, 
and install the license as explained below.

To install a Tempo license, follow these steps summarized from the Vantage Domain 
Management Guide:

1. Place a copy of the license file in a location accessible to the Tempo Server.

2. Start the Vantage Management Console by double-clicking its desktop icon.

3. In the Vantage Management Console left panel, select Licenses.

4. In the right panel, click the Add License button to display the Add/Update License 
dialog.

5. Navigate to the license location, select the license, and click Open. 

If this computer has an Internet connection, Vantage prompts you to accept the 
license agreement. If an error message appears, see Troubleshooting License Installa-
tion Problems in the Vantage Domain Management Guide to activate the license 
without an Internet connection.

6. Click I Accept... if you agree to the license terms, and click OK.

7. Read the Licensing Changed dialog and click OK. This completes license 
installation. 

8. Next, in the Vantage Management Console, click Services in the left column. 

9. Select all services that are in Maintenance mode for which you have a license (Ctrl- 
or Shift-click to select multiples). 

10. Click Exit Maintenance Mode (in the tool bar) to restart all the selected services to 
return them to their normal, operational state. All licensed services should now be 
in the green (Online) state, and Tempo should be enabled.

mailto:enterprisesales@telestream.net
http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/VantageDomainManagement.pdf
http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/VantageDomainManagement.pdf
http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/VantageDomainManagement.pdf
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Configuring Tempo
Configuring Tempo is essentially a subset of the tasks required to set up a Vantage 
domain generally, including creating stores, catalogs, Tempo Portal configurations, 
workflows, and deploying the Vantage Workflow Portal program on client computers.

If you are familiar with these tasks, you may be able to skip the detailed steps presented 
below and simply skim each topic for any special details before performing the task. If 
you are not familiar with these tasks, detailed steps are provided to guide you. 

The following topics describe the required configuration tasks:

 Ensuring Maximum Server Performance

 Adding Vantage Users

 Enabling Open Workflows

 Creating Vantage Stores

 Setting the Edit Service’s Session Limit

 Creating Catalogs

Ensuring Maximum Server Performance
To ensure maximum server performance, set the Control Panel Power Options to High 
Performance with Sleep disabled:

1. Navigate to Start > Control Panel > Power Options.

2. Select the High Performance plan. 

3. Set Sleep mode to Never (never sleep).

4. Select Change advanced power settings, and set all critical functions so that they are 
always ON (this usually means setting them to Never turn OFF).

Also disable any real-time processes that may interfere with performance, such as virus 
scanning of media files as they are being captured, automatic real-time software 
updates, and real-time file indexing. 

Adding Vantage Users

Note: Adding users is optional, depending on whether your Vantage domain has 
User Administration enabled. You can you use Tempo without enabling User 
Administration—skip this topic if that is the case.

Before anyone can use a Vantage Tempo system with User Administration enabled, you 
must add them as users in the Vantage Management Console. You can create users 
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directly in Vantage or you can also select Use Windows Active Directory for Users to allow 
logging in using Windows accounts.

For details on creating users in Vantage, see the Vantage Domain Management Guide.

Adding Users
The procedure to add users differs slightly depending on whether you use Windows 
Active Directory or not. 

Adding Users Without Windows Active Directory

To add a new user without using Windows Active Directory, follow these steps:

1. Click the New User button  or right-click and select New User. 

2. Enter the username and password (and confirm the password) in the dialog box. 

3. Check the Administrator check box if you want the new user to be an administrator. 

4. Click OK to add the user, and then click Save  to save your changes.

Adding Users With Windows Active Directory

The Vantage Active Directory feature allows you to create users and groups in Windows 
Active Directory and add them as users with or without administrator privileges:

1. Click the New User button  or right-click in the empty user list and select New User. 

2. Enter part or all of the user name in the blank field and click Find Now to search for 
and list users whose names match the text you entered. 

The drop-down menu lets you select a filter for your search, and the Users and 
Groups check boxes allow searching for users, groups, or both (default).

3. Select a user in the displayed list.



Configuring Tempo Resources
Configuring Tempo

23

4. Check the Administrator check box if you want the new user to be an administrator. 

5. Click Add to add the user, and then click Save  to save your changes. 

Setting Passwords
To set the password of a user, click the Set Password button (or right-click the user in 
the list and click Set Password). When the dialog box displays, enter the password (and 
confirm the password) of the user. Click OK to close the dialog box, then click the Save 
button  to save your changes.

Removing Users
Remove users by selecting the user in the Users list and clicking the Delete button  at 
the top of the User Management panel (or right-click the user and select Delete). 

Importing and Exporting Users
User lists can be imported and exported. To import a list of users, click the Import 
button , navigate to the XML file containing a list of users, and click the Open button. 
To export a list of users, click the Export button  (or right-click the list and select 
Export), enter an XML filename for the list of users, and click the Save button.

Enabling Open Workflows
You may enable Open Workflows in Vantage when using the Tempo Two Pass feature to 
help your workflows operate more quickly, but it is not required. In the Vantage 
Management Console, access Settings & Options, General tab, and check the Enable 
Open Workflows option. Also, enable Open Workflows at the top of the Workflow 
Designer and in each action.

Creating Vantage Stores
Before you can begin configuring Tempo, you must have a fully-operational Vantage 
domain with Vantage Stores (folders) for holding interim results of Vantage and Tempo 
workflow processing. The stores are where Tempo will place temporary output media 
and other files that it produces before you use other workflows to move them to their 
final destination, such as a media or broadcast server. 
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If you have not already done so in the Management Console, create Vantage stores as 
needed (skip this topic if your stores are already configured). For additional details 
about stores, See Managing Vantage Stores in the Vantage Domain Management Guide.

Setting the Edit Service’s Session Limit
The session limit for each Vantage service determines the maximum number of 
concurrent sessions (actions that can execute) for a given service. This value is displayed 
in the Vantage Management Console > Services > Session Limit column. The default Edit/
Tempo limit is 4 and the recommended limit is 2. To change the session limit:

1. Open the Vantage Management Console and display the Services panel. 
2. Right-click the Edit service, and select Enter Maintenance Mode.
3. Select the Setup tab at the bottom of the window. 
4. Click the Service Limits Configuration Item, and set the Session Limit to 2. 
5. Click Apply.
6. Right-click the Edit service again, and select Exit Maintenance Mode.

Note: Changing the Edit service session limit affects all Edit actions, including, for 
example, the number of Conform jobs you can run. Specify Run On rules to dedicate a 
given Edit service to Tempo actions and avoid unnecessarily affecting other actions.

Creating Catalogs
The starting point for organizing assets for re-timing is the catalog. Operators access 
media in the Tempo Portal by browsing catalogs and then selecting a binder (media 
files with metadata and variables) that has been ingested and pre-preprocessed and 
registered in the catalog to re-time.

You need to create at least one catalog to hold binders generated from each asset 
processed in a Tempo ingest workflow. For the Tempo Two Pass feature, it is convenient 
to create a single Tempo catalog with two catalog folders: Pass 1 and Pass 2.

The Pass 1 catalog folder should be the target of the ingest workflow. The Pass 2 catalog 
folder should be the target of the first pass Tempo workflow.

If you have not already done so, use the Vantage Domain Console to create Vantage 
catalogs as needed (skip this topic if your stores are already configured). For additional 
details about catalogs, See Managing Vantage Catalogs in the Vantage Domain 
Management Guide.

http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/VantageDomainManagement.pdf
http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/VantageDomainManagement.pdf
http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/VantageDomainManagement.pdf
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Creating Tempo Portal Configurations
Before you can use Tempo, you will need to create a Workflow Portal configuration for 
Tempo Portal and configure it to meet your application’s requirements. 

Note: When an operators loads the Tempo Portal configuration into Workflow Portal 
to use it for processing assets with Tempo, Workflow Portal is commonly referred to 
simply as Tempo Portal, rather than the formal Workflow Portal Tempo Configuration.

Workflow Portal configurations are created, configured, and managed in the 
Management Console. As you make configuration selections, you are customizing the 
features, functionality, and user interface of Workflow Portal’s panels and labels. 

All of the configuration options are grouped in tabs to make the task easier. Some tabs 
are specific to Tempo Portal; others are general, and are present in many (or all) 
Workflow Portal configuration types.

Note: After you’ve created a configuration, select it to configure it. Or, when you want 
to modify an existing configuration, select it to make changes. Always click the Save 
button  to update the configuration.

 Creating a Workflow Portal Tempo Configuration

 Configuring Tempo Settings
 Specifying Access to Catalogs
 Configuring the Binder Details View
 Adding and Configuring Metadata Labels
 Adding Rating Systems Variables
 Configuring Graphic Settings
 Configuring Embedded Metadata Settings
 Specifying Workflow Submission
 Configuring Storage Utilization
 Setting Permitted Users
 Managing Configurations
 Creating Two Pass Portal Configurations
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Creating a Workflow Portal Tempo Configuration
To create a Workflow Portal configuration for Tempo Portal, follow these steps:

1. Start the Vantage Management Console and connect to your Vantage domain.

2. Select Application Configurations > Workflow Portal to display this panel:

3. Click the Create configuration button .

4. Update the following general settings per your requirements:

a. Name: Enter the name of the new configuration as appropriate.
b. Description: (Optional) enter a description of the new configuration as 

appropriate.
c. Mode: Select Re-time Asset from Catalog (create binder) from the Mode drop-

down menu to create a Tempo Portal configuration.
d. Use Dropframe Notation: When checked, displays duration timecodes in 

dropframe notation when in and out points are specified in dropframe notation.
e. Pass username as: When checked, allows you to set the username of the portal 

operator as a variable that you can use in workflows. This can be helpful, for 
example, to address a message to an operator based on the results of a workflow.

5. Click the Save button  to save your new Tempo Portal configuration.
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Configuring Tempo Settings
The Tempo Settings tab allows you to specify standard settings to use for increasing or 
decreasing media duration and handling subtitles and captions:

1. Select the Tempo Settings tab, as shown above.

2. Select the caption’s re-timing features to enable and controls that you want to 
display in Tempo Portal’s Tempo Settings tab.

Read Only: Each of these controls has a Read Only control, which you can check to 
disallow changing the setting directly in Workflow Portal. When checked, the set-
ting is displayed in a read-only view. Uncheck to allow Workflow Portal operators to 
change the setting.

–  Preserve and re-time captions: Selects whether to include and re-time 
captions together with the re-timed media. Applies to embedded captions and 
caption files.

– Use subtitle/caption file: Allows the operator to enter a path or browse and 
select an SCC (.scc) or STL (.stl) caption/subtitle file for inclusion with the media 
output. Telestream’s CaptionMaker software lets you create captions and save 
them in SCC or STL files if you need an application to do that.

– Subtitle/caption file: When Use subtitle/caption file is enabled, the operator 
must enter a path or browse and select an SCC or an STL caption/subtitle file 
(with file extensions scc or stl) for inclusion with the media output.

– Subtitle/caption offset sign: Allows the operator to set the start time of 
captions forward (+) for a later start or backward (-) for an earlier start relative to 
the specified starting timecode in the SCC/STL or STL file. Use the Subtitle/caption 
offset described below to set the amount of offset.

– Subtitle/caption offset: Sets the amount of start time adjustment to apply to 
captions or subtitles relative to the start time specified in the caption or subtitle 
file. Use the +/- sign described above to set caption start time earlier or later.

– Set timecode at: Determines where to start or end timecode in the re-timed 
output. You can preserve existing source timecode, start timecode at the first 
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frame or end it on the last frame of the program, or start it on the first frame or 
end it on the last frame of the output file.

– Re-time: Determines what type of re-timing operation to perform:

– Set Total Duration: Re-time the asset to adjust the time to a total set amount, 
specified in the Amount field.

– Set Percent: Re-time the asset to adjust the time up or down to a specified 
percentage of the total, specified in Sign and Change fields.

– Increase Duration by: Re-time the asset to increase the time by a set amount, 
specified in the Amount field.

– Decrease Duration by: Re-time the asset to reduce the time by a set amount, 
specified in the Amount field.

When Set Total Duration | Increase Duration | Decrease Duration are selected, spec-
ify the amount of time to use. When Set Percent is selected, specify negative (-) or 
positive (+) to decrease or increase the amount of time and supply the percent.

3. Click the Save button  to save your changes.

Specifying Access to Catalogs
Tempo allows you to specify which catalogs (and their binders) are accessible to Tempo 
Portal operators:

1. Select the Browsable Catalogs tab (shown in the previous figure).

2. To make a catalog visible, select the catalog in the Available list in the left panel, and 
click Add. This moves the catalog to the Visible to user list on the right. 

3. To remove a catalog from the Visible to user list, select the catalog and click Remove.

4. Click the Save button  to save your changes.

Only catalogs (and their binders) in the Visible to user list on the right can be seen by 
Tempo Portal users. 

Note: If you don’t put any catalogs in the Visible to User list (you leave it empty), then 
all catalogs (both existing, and newly created ones) will be displayed in this list.
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Selecting the Show Media Nicknames List Option
The media list displays the media files for a binder that you select. For example, the 
media list includes the original media submitted to a workflow and the output media 
from that workflow. Typically, it will also display the proxy file. When the media list is 
visible, operators can play the media or view the contents of the folder that contains 
the media.

To display the media list, check the Show media nickname list check box in the 
Browsable Catalogs panel.

Click the Save button  to save your changes.

Selecting the Require All Expected Nicknames Option
For Tempo configurations, you typically check Require All Expected Nicknames. The 
publishing workflow’s required nicknames identify each resource associated with an 
asset that is required for processing. These resources must be present in the binder. 
Otherwise, the Receive action will fail, and so will the workflow. 

Click the Save button  to save your changes.

Enabling and Disabling Binder Deletions
By checking the Allow Binder Delete check box, you are allowing operators to remove 
binders from the catalog after they’ve been process and submitted, leaving only 
binders that have not yet been processed. This effectively makes the catalog a 
manually-managed drop-box that operators can control at their discretion. 

If you prefer to save binders and do not want operators to delete them, uncheck the 
Allow Binder Delete check box. 

Note: Binder deletion is also controlled by expiration times defined in the workflow 
Register action or catalog configuration.

Click the Save button  to save your changes.

For more information about how binders are handled, see Understanding Binders in the 
Vantage Domain Management Guide.

http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/VantageDomainManagement.pdf
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Configuring the Binder Details View
Vantage allows you to control the columns and metadata label parameters displayed in 
the binder list by making selections in the Binder Details View panel, as shown here:

1. Select the Binder Details View tab in the Tempo Portal Configuration.

2. Select each check box to display the item or clear the check box to hide it:

– Binder name: Displays the name assigned to the binder when it was created.

– Created: Displays the date and time the binder was created.

– Expiration: Displays the date and time the binder expires.

– Play button: Displays a button the operator can use to play the selected jobs 
proxy video.

Notes: Vantage allows you to hide all columns in the binder list, producing an empty 
list. Configure at least one column to display so that the binders display in the list.

The play button operates only when the workflow has generated and registered a 
proxy file (see the Using Workflow Portal topic in the Vantage User Guide), which is a 
requirement for Tempo configurations. 

1. Click the Column button .

2. For each metadata label parameter you want to display in a column:

a. Select a metadata label in the Labels panel.
b. Select the check box for the metadata label parameter in the Parameters panel.
c. When you are done making changes, click OK.

3. For each metadata label parameter you want to remove from the binder view:

a. Select the parameter you want to delete in the parameter list.
b. Click the Delete button  and confirm the deletion.

4. To change the displayed order of parameters:

a. Select a parameter in the list (Ctrl-click or Shift-click for multiple selections)
b. Use the green up  and down arrow  buttons to move the variables.

5. Click the Save button  to save your changes.

http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/Vantage-User-Guide.pdf
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Adding and Configuring Metadata Labels
Vantage allows operators to view and modify values in metadata labels when they 
submit jobs to a workflow. They are used by the workflow to control media processing.

Note: Before a metadata label can be made available to users, it must be defined 
using the Vantage Management Console. See Creating Metadata Labels and also 
Understanding Metadata Labels in the Vantage Domain Management Guide.

Only labels are visible are those that are specified as such in the portal configuration. 
Typically, at a minimum you’ll select the Identify label which holds values about the 
source asset specified in the ingest workflow: 

1. Select the Labels tab (see above) in the Tempo Portal Configuration.

2. To enable visibility of metadata labels, check the Show Metadata Labels check box.

3. To allow operators to add and delete metadata labels for a given submission, check 
the Allow Add/Delete check box. Typically, this is unchecked in Tempo applications.

4. To make specific metadata labels available to operators, select labels in the 
Available panel. (Ctrl-click or Shift-click to select multiples) and click Add to move 
them to the Visible to Users list.

5. To change label order, select labels in the Visible to user list (Ctrl-click or Shift-click to 
select multiples) and use the green up  and down arrows  to re-arrange the 
labels.

6. Click each label and use the center buttons (between the two lists) to set optional 
parameters: trim group in, out, and duration time codes, and hot keys for 
transferring trim group time codes to labels. 

7. Click the Save button  to save your changes.

Adding Rating Systems Variables
You can set up specific variables as needed if you are using the Content Advisory 
feature, for example. 

http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/VantageDomainManagement.pdf
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Note: For an introduction to Vantage variables, see Understanding Variables in the 
Vantage Domain Management Guide.

To enable operator to use these variables, follow these steps:

1. Select the Variables tab (shown here) in the Tempo Portal Configuration.

Note: Before a variable can be made available to an operator, it must be defined as 
described in Creating Variables in the Vantage Domain Management Guide.

2. To make a variable available, select its check box.

3. Select the variable to use from the drop-down menu.

4. Click the Save button  to save your changes.

Configuring Graphic Settings
The Graphic Settings tab allows you to select and set the display parameters for a 
station branding logo (bug) and for a content rating image. The Content Branding logo 
can be composited from up to five graphic layers and added to a segment in the Tempo 

http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/VantageDomainManagement.pdf
http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/VantageDomainManagement.pdf
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Portal by checking the Branding during segment check box for that segment. The rating 
image is displayed by checking the Rating graphic at start check box for that segment.

Content Branding Logo or Rating Image Configuration
To configure the Content Branding logo or Rating image, follow these steps:

1. Click the Content Branding or Rating drop-down menu to access the settings.

2. Click Browse to specify the path to the branding logo, or click Placement & duration 
and select Custom to change settings for the Rating image. (Note that not all 
settings listed below for the logo are available for the Rating and vice versa.)

3. Modify the graphic layering, positioning, and appearance settings:

Logos and images can be added as layered overlay images. The origin or default 
starting point for the logo or image is in the top left corner.

– Layer name, Overlay: Enter a name for the layer, and browse for the graphic. 
Select Read Only to prevent operators from changing the settings.

– X, Y: Enter x and y coordinates for the graphic location. Select units in percentage 
or pixels from the drop-down menu.

– Width, Height: Enter graphic dimensions. Select units in percentage or pixels.
– Opacity: Enter the percentage of logo opacity.
– Duration: Enter the length of time that the graphic will appear in the segment in 

minutes, seconds, or frames. Check Entire segment if you want the logo on 
throughout the segment.

– Frequency: Enter how often the logo will appear in minutes, seconds, or frames.
– Fade duration: Enter graphic fade in and fade out duration in seconds or frames.



Configuring Tempo Resources
Creating Tempo Portal Configurations

34

Configuring Embedded Metadata Settings
The Embedded Metadata Settings tab allows you to configure default content ratings 
that you want to show up in the Embedded Metadata panel: 

• Select the default Rating system (MPA, US TV, Canadian English, Canadian French)

• Select the default Rating.

• Check the content descriptions you want checked by default.

Select Read Only to prevent Tempo Portal operators from changing settings.

Setting Timeline Settings
The Timeline Navigation tab includes settings for the Silence buttons on the Preview 
panel timeline. 

Silence level threshold—Sets the level for detecting silence. Default: -40db.

Silence duration minimum—Sets the minimum number of frames defining a period of 
silence. Default: 1 frame.

Artifact Quality Threshold—Sets the default Artifact quality threshold that displays in 
the Tempo Portal Timeline tab. Default: 100%.
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Specifying Workflow Submission
Tempo Portal operators complete the re-timing process by forwarding the re-timing 
composition file to a publishing (Tempo re-timing) workflow where the re-timing 
process occurs. 

Operators can forward the composition to any visible target workflow by selecting the 
workflow on the Forward to Workflows Portal tab and clicking Submit. If a target 
workflow is required, it is automatically selected on the Forward to Workflows tab and 
the binder is forwarded to the required workflow when the operator clicks Submit. 

For Tempo Two Pass, binders in a Pass 1 catalog folder should be forwarded to a first 
pass Tempo workflow. Binders in a Pass 2 catalog folder should be forwarded to either a 
second pass Tempo workflow or a direct convert workflow. 

For workflows to be visible to the operator, they must be added to the Visible to user 
column in the Forward to Workflows tab.

1. Select the Forward to Workflows tab (shown here).

2. To enable operator viewing of target workflows, select the Show Forward to 
Workflows check box.

Note: If all target workflows are required (indicated by the checked Req'd control), 
then you can uncheck the Show Forward to Workflows check-box to reduce the 
number of clicks for the operator.

3. To make target workflows available to operators, select one or more workflow 
names in the Available panel and click Add.

Note: To accept forwarded binders, the target workflow must start with a Receive 
action. The Available panel only displays workflows with a Receive action.

4. To specify whether a target workflow is required for forwarding or optional, check 
the Req’d check box next to the workflow in the Visible to user panel.

5. Click the Save button  to save your changes.
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Configuring Storage Utilization
The composition files created by the Tempo Portal can be stored in any Vantage store 
or folder. The Storage tab lets you select the storage location.

 

Note: The Microsoft User Account Control (UAC) feature may deny access to Vantage 
stores or folders that are placed in protected locations. If Vantage users report that 
access to a Vantage store or folder is denied, do one of the following: 
1. Place the store or folder in a directory that is not protected by UAC. 
2. Use the procedure below to specify a different store or folder. 

1. Select the Storage tab.

2. Choose an option:

a. To store files in any available Vantage store, select Available Vantage Store.
b. To store the files in a specific Vantage store or folder, select Vantage Store/Folder, 

and choose a Vantage store or folder from the drop down list.

3. Click the Save button  to save your changes.

Setting Permitted Users
The Permitted Users panel defaults to the Everyone check box so that all Vantage users 
have access to the Tempo Portal configuration.

Note: The Permitted Users tab only displays when User Administration is enabled in 
your Vantage Domain.

To grant access to selected users only, uncheck Everyone. Then click names in the left 
column and use the Add button to move the names you want to have access into the 
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Permitted users column on the right. To remove users from access, click their names in 
the right column, and click Remove.

Managing Configurations
Once your Portal configuration is complete, you can manage it in these ways by 
selecting the configuration and using the following toolbar buttons: 

• Click the Refresh button  to refresh the configuration list.

• Click the Delete button  to delete the configuration.

• Click the Duplicate button  to create a copy of a configuration.

• Click the Export button  to export a single configuration as an XML file, or select 
Export all from the Export button drop down menu to export all configurations.

• Click the Import button  to import a previously exported configuration XML file.

• Click the Save button  to save configuration changes.

You can also right-click on a configuration or in the blank area below the configurations 
to open a context menu providing access to the same tools described above.

Creating Two Pass Portal Configurations
Using a single portal configuration works best for Tempo Two Pass. This allows both 
Pass 1 and Pass 2 catalog folders to be seen and used in the same configuration. A 
suggested configuration is described below. (For details about the associated 
workflows, see the Tempo Workflows chapter in this guide.)

The Tempo portal configuration provides a portal operator access the Tempo catalog, 
which allows the operator to selectively submit to any of the following workflows:

• Tempo Ingest

• Tempo Pass 1

• Tempo Pass 2

• Tempo Direct Convert

The setup of the Tempo configuration is displayed below. 
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Note: Only the relevant sections of the configuration are presented here (in particular 
the catalog access and the available workflows.)



Configuring Tempo Resources
Deploying Portals on Client Workstations

39

Deploying Portals on Client Workstations
As a Vantage domain administrator, you can make it easier for operators to start using 
the Tempo Portal by doing the following:

1. Install the Vantage client programs on operator workstations. 

a. Log on to the target workstation with a local administrator account, and make 
sure that virus-checking software and Windows Firewall is off.

b. Copy the Vantage 8.0 Client Application.msi installer or the Vantage_8.0_Setup.exe 
installer to the workstation, or make the installer available on a network share.

c. Run the Vantage 8.0 Client Application.msi installer or the Vantage_8.0_Setup.exe 
installer, and select the Vantage Workflow Portal and any other desired clients for 
installation.

2. Launch and configure the Vantage Workflow Portal for the first time:

a. Select the Vantage domain (File > Change Vantage Domain).
b. Choose the Tempo Portal when you are offered a choice of configurations, or if 

there is only one configuration available, it is opened automatically. 
(You can also manually select and load a Tempo Portal configuration after the 
Portal starts by selecting File > Change/Reload Application Configuration.)

c. Select the Tempo catalog, which will display the binders available for selection 
and processing by the operator.

Tempo is now ready for use. The next steps are to import or create Tempo workflows as 
explained in the Tempo Workflows chapter and to begin using the Tempo Portal as 
explained in the Using Tempo to Re-time Media chapter.
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Using Tempo to Re-time 
Media

Tempo provides a Tempo Portal which you use to select a clip (asset) and create 
segments, scrub a proxy of the source media which you want to re-time, mark 
segments to include or exclude from re-timing, and specify how much time expansion 
or compression to apply.

Clips can be automatically segmented by use of slate/bars/black detection with the 
Analyze action in an ingest workflow. Tempo Portal can be used to adjust the auto-
segmentation report from the Analyze action’s Scene Change Analysis filter, or the 
Portal can simply be used to manually apply segmentation.

When clip segmentation and other related tasks (metadata, branding graphics, etc.) are 
complete, Tempo Portal (behind the scenes) generates a composition file to describe 
re-timing requirements for the asset. You as the operator forward the asset to a Tempo 
publishing workflow to process the source media—the Tempo action in the workflow 
re-times the video during transcoding. 

Note: If you haven’t yet set up Tempo in Vantage, you need to configure your Tempo 
Vantage domain to meet your requirements. Use the Tempo Quick Start to set up 
Tempo in your environment and learn how to re-time media through the two 
workflows, utilizing Tempo Portal. For full details on any set-up task, you can refer to 
Configuring Tempo Resources.

Topics
 Overview of Tempo Portal

 Tempo Quick Start

 Using Tempo Portal

 Tempo Portal Menus
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Overview of Tempo Portal
Tempo includes a specially-designed Workflow Portal template for re-timing media 
assets. Tempo Portal configurations are created from the Tempo template in the 
Vantage Management Console > Workflow Portal Configurations panel. 

Tempo Portal includes these panels (see the Tempo Portal Main Panels figure below):

• Catalogs Panel: Lists catalogs available in the Tempo configuration.

• Binder List: Shows media binders of each asset or clip processed in a Tempo ingest 
workflow in the catalog, available for re-timing.

• Preview Player: Plays the proxy in the selected binder. Includes standard player 
controls. Segment start points, scene changes, and Two Pass quality issues are 
marked on the timeline with white, green, and orange tick marks. The player can 
also seek the next or previous silence segment (not shown with tick marks). Any 
overlapping segments are highlighted in red and should be re-marked to eliminate 
overlaps. Timeline scale and history controls allow expanding and navigating the 
timeline. A button above the player allows maximizing the panel area.

• Tabbed Panels: Includes a Segment List for configuring segment re-timing, and 
other tabs: Metadata Labels, Embedded Metadata, Graphic Settings, Tempo Set-
tings, Timeline, and Forward to Workflows.

• Re-time Panel: Sets the type and duration or re-timing amount for the entire asset.

Catalogs Panel List Binders by Details or ThumbnailsBinder List
Binder FilterRefresh Catalog

Re-Time Panel & Details

Segment List Segment Details

Tabbed Panels

Preview Player

Timeline scale & 
history controls

Timeline
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Tempo Portal includes these capabilities:

• Browse binders in the selected Vantage catalog

• Drag a binder into the segment list, automatically creating segments identified 
during analysis in the ingest workflow

• Preview the proxy to create clip segments and set Mark In/Out to identify them

• Select options to include a segment in program, re-time the segment, include 
graphic overlay (bug), and include rating graphic

• Set re-timed total duration or increase/decrease the total time.

This image illustrates the general process an operator uses to set up a job for a 
particular file of media and submit it for re-timing.

1. Select a 
catalog.

2. Select clips 
from the 
catalog.

3. Drag clips 
from the 
catalog to the 
segment list.

4. Preview 
segments.

5. Mark the 
segment in/out 
points & check 
options.

6. Set the 
amount of re-
timing.
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Tempo Quick Start
This topic describes the entire Tempo operational process from start to finish in just a 
few pages. If you follow the steps as you read them, you’ll have set up and configured 
Tempo for use, and re-timed your first asset in Tempo when you reach the last step. 

You can create as many catalogs, workflows and Tempo Workflow Portal configurations 
as needed to implement various re-timing applications in your environment.

This topic generally describes what to do; for how to do each tasks,refer to details 
elsewhere in the guide:

• Configuring Tempo Resources—setup tasks described in detail

• Creating Tempo Portal Configurations—details about setting up Tempo Portal con-
figurations to meet your operational requirements

• Tempo Workflows—for details about creating and configuring Tempo workflows

Steps to Set Up Tempo
To initially set up Tempo in Vantage, follow this sequence of tasks:

Tempo Setup Topics
 Enable Open Workflows

 Create Tempo Catalogs

 Create an Ingest Analysis Workflow

 Create a Tempo Re-Timing (Publishing) Workflow

 Configure a Tempo Portal Configuration

Note: Other initial setup tasks may be required, including licensing, Vantage user 
management, Vantage stores, setting Edit Service session limits, and Workflow Portal 
deployment. For details, refer to Configuring Tempo Resources.
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Enable Open Workflows
You may optionally enable Open Workflows in Vantage when using the Tempo Two 
Pass feature. In the Vantage Management Console, access Settings & Options, General 
tab, and check the Enable Open Workflows option. 

Also enable Open Workflows at the top of the Workflow Designer and in each action.

Create Tempo Catalogs
Your media files must be processed by an ingest workflow and all assets registered in a 
Vantage catalog for access in Tempo Portal. For a single-pass re-timing, a single catalog 
will work. For two-pass re-timing, you may want to use two catalogs, or a single catalog 
with two target folders for Pass 1 and Pass 2. Use the Vantage Management Console 
Catalogs panel to create catalogs. For details, see Creating Catalogs in the Configuring 
Tempo Resources chapter.

Create an Ingest Analysis Workflow
Create a Vantage ingest workflow to perform these tasks:

• Watch a hot folder for incoming media and submit a job

• Analyze the media you want to re-time for fundamental characteristics

• Create a proxy of the original file for scrubbing

• Optionally, create a thumbnail of a scene to represent the media in the portal

• Populate a metadata label, such as the Identify Label, with details such as frame 
rate, resolution, and scan type from the Analysis action.

• Register the asset and all associated resources (original, proxy, thumbnail, etc.) in a 
Vantage catalog

Use this ingest workflow to process all of the media you plan to re-time to create the 
proxy and optional thumbnail, and register the job results in a Tempo catalog.

A typical Tempo Ingest Workflow is presented in detail in the Tempo Workflows chapter. 
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Create a Tempo Re-Timing (Publishing) Workflow
Create a re-timing workflow using the Tempo action. This is the workflow to which you 
will forward re-timing instructions from the Tempo Portal. The workflow will then 
process and output the re-timed media file.

The minimum workflow contains a Receive action configured to receive the CML (XML) 
composition file (Expected Nicknames = CML) from the Tempo Portal and a Tempo 
action configured to do the re-timing. For an example Tempo Re-Timing Workflow, see 
the Tempo Workflows chapter.

Note: Beginning with Vantage 8.0 UP1 with Tempo ComponentPac 8.0.1, the Tempo 
action is available in the Telestream Cloud. Refer to the Vantage Cloud Port User Guide 
for details about using the Tempo action and other Vantage actions in the Cloud. 

Configure a Tempo Portal Configuration
Before you can use Tempo Portal, use the Vantage Management Console to create and 
configure a Re-time Asset from Catalogs (Create Binder) Workflow Portal configuration. 
This type of configuration makes the Workflow Portal into a Tempo Portal.

For complete instructions, refer to the Configuring Tempo Resources chapter.

Steps to Re-Time Video in Tempo
To re-time media files using Tempo, you follow a sequence of operations employing 
workflows and using the Tempo Portal to prepare and submit jobs. The overall process 
follows the order of these topics:

Tempo Operational Topics
 Pre-process Media through the Ingest Workflow

 Load a Tempo Configuration into Workflow Portal

 Create and Configure Segments for Re-timing

 Merging Segments

 Forward the Job to the Tempo Re-Timing Workflow

Pre-process Media through the Ingest Workflow
After completing the preparatory steps, you can submit media to the ingest workflow 
to extract metadata, create a proxy, and register it as a binder in a catalog. 
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1. Activate the ingest workflow you plan to use.

2. Submit one or more media files that you want to re-time to the ingest workflow.

3. When each job has completed successfully, proceed.

Load a Tempo Configuration into Workflow Portal
With your media now in the catalog, you can use Tempo Portal to select, segment, and 
process media.

1. Launch Workflow Portal by double-clicking the desktop icon.

2. Observer the Vantage domain at the top of the window. If required, select File > 
Change Domain to change your Vantage domain.

3. Select File > Change/Reload Application Configuration and select the Tempo 
configuration you created in the Vantage Management Console.

(Workflow Portal remembers the domain and configuration you last used.)

Create and Configure Segments for Re-timing
Use the Tempo Portal for scrubbing your media files to re-time them:

1. Select the catalog in the Catalogs list. The catalog’s binders display as clip icons or a 
detailed list in the binder panel, to the right of the catalog list.

2. Click the Segment List tab in the lower right quadrant of Tempo Portal.
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3. Click and drag the binder you want to segment from the binder list into the 
Segment List (or click the + (plus) button in the Segment List to add the selected 
binder to the list).

If a segment analysis report was generated in the ingest workflow, the identified 
segments and scene change markers can optionally be added to the list:

You can also view the (XML) segment analysis report via the View Report button or by 
right-clicking the binder clip in the top clip list and selecting View Analysis Report. 

Note: Segment markers display in white on the media player timeline and the 
segments themselves display in blue. Scene change markers display in green. To 
display or hide these markers, select Options > Display Segment Markers | Display 
Scene Change Markers. Or, right-click on the scrubber and select the same options 
from the context menu. To jump to segment markers, press the Alt+ Left | Right Arrow 
keys. To jump to scene change markers, press the Shift-Alt+ Left | Right Arrow keys

4. Click OK to automatically add the selected types of segments and scene change 
markers (or Cancel if you plan to add markers manually).

Note: When you click OK to add auto-segmentation, the Segment List spans the 
entire source file via one or more segments. Creating additional segments is not 
allowed, but you can review the automatically generated segments and adjust their 
mark in and mark out points as explained in the next steps.

5. Select each segment to verify its settings and configure it for processing as 
appropriate. To adjust segments, click and move the segment markers in the 
preview player. 

If you are entering segments manually, use the Mark In and Mark Out buttons to 
enter segment start and end points. You can also enter the timecode directly.

For longer programs where you need to see the timeline in greater detail, use the 
player timeline scale controls  to expand the timeline.

For more information about segment marking options, see Managing and Merging 
Segments later in this chapter.
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6. Check the desired functions at the bottom of the Selected Segment panel. 

a. Select Segment is part of program if you want to include the marked segment in 
the re-timed program’s duration. Uncheck this option to exclude the segment 
from the program. 

Note: If unchecked, a segment is included in the output but is not included in the 
original duration for segments to be re-timed. This is typically used for content such as 
bars and tone to be included in the output but not included in the broadcast content.

b. Select Re-time this segment if you want to include it in re-timing. Uncheck this 
option to leave its duration unchanged. If unchecked, a segment is still included 
in the original duration shown to the right of the Re-Time parameter.

c. Select Rating graphic at start to insert a maturity rating graphic in the segment. 
This graphic is defined in the Management Console > Application Configurations 
> Workflow Portal > Tempo Configuration > Graphic Settings.

7. Click Advanced to override these Tempo action settings for this segment:

See Applying Advanced Tempo Settings for control details.

8. If you are marking segments manually, right-click the segment, and select Duplicate 
(Ctrl-t) to create the next segment with Mark In timecode starting where the 
previous segment ends. 

9. Repeat the preceding steps to configure the next segment and to create and 
configure additional segments. 

When finished, you should have divided the entire asset or clip into segments and 
marked them for inclusion/exclusion and re-timing. 

Note: Sometimes the segmentation process—especially automatic segmenta-
tion—may result in gaps or overlaps between segments. See Merging Segments to 
learn how to fix this problem.

10. Select the type of re-timing (longer or shorter, using integers or real numbers) at 
the bottom of the window, and set the duration or percent of change. More change 
is likely to reduce quality on a sliding scale, of course.
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As you modify the duration, the percentage is automatically re-calculated, and the 
text color may change to indicate the feasibility/quality of the proposed re-timing. 

These are the methods:

– Set Total Duration—re-times the overall program duration to match the new 
duration for the program you specify.

– Set Percentage—re-times the overall program duration by the percentage you 
specify. Specify the percentage as + or - to lengthen or shorten the program by 
the specified percentage. You can’t manually enter a percentage greater than 10.

– Increase Duration by—increases the overall program duration by the amount 
specified.

– Decrease Duration by—decreases the overall program duration by the amount 
specified.

The Change line displays the re-timing you have specified. Green indicates an 
amount (up to 9%) that is likely to yield higher quality results. Yellow indicates a 9% 
or greater change, signaling a likely material reduction in quality, and red indicates 
a change percentage of 10% or greater. If the Change line is red, you must alter the 
re-timing values to specify a valid percentage before submitting the job.

When altering re-timing in a two-pass configuration, select the first pass workflow.

Merging Segments
Segment creation may result in extra segments that need to be manually removed. This 
process can cause gaps, overlaps, or redundant partitioning. The Merge Segments 
feature provides a simple way to merge multiple segments into a single segment. 
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Merging will result in a new segment with Mark In set to the Mark In point of the first 
selected segment, and Mark Out set to the Mark Out of the last selected segment.

1. Ctrl-click or Shift-click to select multiple segments for merging.

2. Right-click the selected segments, and select Merge Segments.

3. Make selections in the Merge Segments dialog:

– To re-time all selected segments, check both options.

– To ignore all select segments, check Segment is Part of Program and uncheck Re-
time this Segment.

– If none of the selected segments are of the program, uncheck both options.

– If selected segments are of different types (retimed, un-retimed, not included), 
check both options.

Note: When merging into a retimed segment, Tempo preserves the Advanced 
settings. If several segments to be retimed are selected, and their Advanced settings 
do not match, Tempo reports an error and cancels merging.

Forward the Job to the Tempo Re-Timing Workflow
After you configure your media for re-timing, submit the job to the Tempo re-timing 
workflow:

1. Activate the Tempo re-timing workflow you created earlier.

2. Select the Forward to Workflow tab in the Tempo Portal.

3. Check the Tempo re-timing workflow that you want to use, and click Submit. (When 
altering re-timing in a two-pass configuration, select the first pass workflow.)

This completes the re-timing process. When the workflow completes, your re-timed 
media will be stored in the Vantage Store or location you specified. 

Note: The Tempo Two Pass Feature requires additional steps. For details, see Using the 
Two Pass Feature later in this chapter.
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Using Tempo Portal
This topic describes the Tempo Portal panels and features in detail:

 Using the Catalogs Panel

 Using the Preview Player

 Viewing Metadata Labels

 Viewing and Updating Embedded Metadata

 Specifying and Applying Branding Graphics Files

 Specifying Tempo Settings

 Configuring the Segment List

 Adjusting Total Re-timing

 Forwarding to Workflows

 Using the Two Pass Feature

Note: If you are not familiar with using Workflow Portal’s panels and general features 
to process and submit media, please read the Using Workflow Portal chapter in the 
Vantage User Guide.
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Using the Catalogs Panel
The Catalogs and binders panel runs across the top of the Tempo Portal and allows you 
to select the catalog and binder containing the media you want to work with. 

Catalogs
When you first open the Tempo Portal, you are asked to select an application 
configuration, or you can manually select File > Change/Reload Application 
Configuration. This function loads the Tempo Portal configuration you created in the 
Vantage Management Console, and the configuration specifies which catalogs you will 
be able to see in the portal.

Refreshing Catalogs

To begin using the Catalogs panel, click the Refresh button (two green arrows) to show 
the latest catalogs. 

Selecting a Catalog

Next, click a catalog in the upper left corner, and notice that thumbnails or lists of 
binders appear along the top of the portal. Binders are registered into the catalogs 
when you run Tempo ingest workflows.

You can filter the binder list (if there are multiples) by entering a text term in the drop-
down filter menu, and you can display by thumbnails or details list using the drop-
down menu on the right. The displayed binders contain the media clips that were 
added to them using ingest workflows—both an original clip and a proxy.

Selecting a Binder

Click a binder in order to work on re-timing its clips. The selected binder contents are 
listed above the preview player, and the proxy contained in the binder is automatically 
selected in the list and displayed in the player window.

To work on re-timing the media contained in a binder, click and drag that binder from 
the binder list into the Segment List panel, where you can begin setting up re-timing.

Controls Functions

Catalogs Lists available Tempo catalogs. Click a catalog to select 
it.

Refresh Click the green arrows to refresh the catalog list.

Binder list Lists binders in the selected catalog.

Binder filter Filters the binder list. Enter text to filter on a name.

Thumbnails/Details Toggles between thumbnail and text binder list.
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Using the Preview Player
The Tempo preview player plays media in the selected binder. A list above the video 
displays which files are available in the selected binder. Clicking on a media file in the 
list displays that file in the player window.

The player includes standard player forward, pause, and reverse controls, audio 
controls, and a timeline scrubber, as well as indicators and controls for segment, scene, 
and artifact start points. The player can also seek the next or previous silence segment 
(not shown with markers). Any overlapping segments are highlighted in red and should 
be re-marked to eliminate overlaps. 

Buttons above the player allow opening the folder containing the currently playing 
media, opening the selected media in a default application, and maximizing or 
restoring the size of the image.

A table describing the player controls is presented below.



Using Tempo to Re-time Media
Using Tempo Portal

55

Controls Functions

Open Containing Folder Opens the folder containing the currently selected file.

Open with default program Opens the currently selected file in the default program.

Maximize/Restore Video 
Preview

Toggles between the maximum and normal image size.

Binder File List Lists files in the selected binder. Clicking a file plays it.

Play/Pause Toggles between play and pause.

Bump Reverse Bumps video backward one frame.

Bump Forward Bumps video forward one frame.

Go to End Moves the scrubber to the last frame.

Go to Start Moves the scrubber to the first frame.

Audio Volume/Mute Toggles between sound and mute; slider sets volume. 
Audio bars at video sides provide audio metering.

Timeline Scrubber Slider sets video position on the timeline as indicated by 
the time position and timecode displays. Segments are 
indicated by white markers on the timeline.

Timeline Scaling Controls The timeline scale controls enable expanding (+) and 
contracting (-) the timeline scale and jumping backward 
and forward in timeline history (< >). The C centers the 
timeline slider, which you can slide to see hidden parts 
of the timeline. These controls are helpful for viewing 
long projects where you need to see greater detail.

Segment Segment forward/back buttons jump to next/previous 
segment when you are marking segments for re-timing.

Scene Scene forward/back buttons jump to the next/previous 
scene (timeline green markers). Scene changes are 
provided to the Portal by the Scene Change Analysis 
filter in the ingest workflow’s Analyze action.

Artifact Artifact forward/back buttons jump to next/previous 
artifact (timeline orange markers). Artifacts are only 
present when a Tempo Quality Report detects media 
artifacts where the Quality Threshold is not met after an 
initial re-timing pass.

Silence The silence buttons detect the next/previous silent 
period from the current location. Level threshold and 
duration are specified in the Timeline settings tab.
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Timeline Markers
The timeline markers appear in different colors depending on a marker’s meaning. The 
markers are called out in the figure and explained in the table below. 

Controls Functions

Segment markers Segment markers are white and correspond to the 
mark in and mark out points for the segment.

Scene changes Green markers indicate scene changes. Scene changes 
are provided to the Portal by the Scene Change 
Analysis filter in the ingest workflow’s Analyze action.

Artifacts Artifact markers are orange and are only present when 
a Tempo Quality Report detects that the Quality 
Threshold is not met after an initial re-timing pass.

Segments Segments appear as medium blue bars.

Selected segments A selected segment appears as a light blue bar.

Overlapping segments Overlapping segments are dark red. You must fix 
overlapping segments so they do not overlap.

Selected segments 
(light blue)

Segment markers 
in/out (white)

Segments (blue)Overlapping 
segments (red)

Artifacts 
(orange)

Scene changes 
(green)
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Viewing Metadata Labels
When the configuration permits it, you can view metadata labels forwarded by a 
workflow. The label information can be helpful during configuration. For example, the 
Media Properties label can show the video frame rate, width, and height. The metadata 
displayed changes depending on the label.

When you submit a clip to a workflow for processing, all metadata labels are included, 
so that the workflow can access the metadata and use it as necessary. 
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Viewing and Updating Embedded Metadata
When enabled in a configuration, you can view and update the default Embedded 
Metadata defined by the Tempo Portal Configuration (in the Management Console). 
Your configuration may also allow viewing but not changing.

This table describes the Embedded Metadata Rating panel. This panel allows you to 
select the content rating system from a drop-down menu, the specific Rating from 
another drop-down menu, and check the rating text to display.

Controls Functions

Rating (system) Selects the rating system to use:

- Not Set

- MPA

- US TV Parental Guidelines

- Canadian English Language Rating

- Canadian French Language Rating

Rating (for this program) Selects the rating to apply to this program. The 
ratings available change with the rating system.



Using Tempo to Re-time Media
Using Tempo Portal

59

Specifying and Applying Branding Graphics Files
If you are responsible for selecting branding files on a per-job basis, your Tempo Portal 
configuration Graphic Settings tab will be configured to allow you to browse and select 
these files. (The graphic tab is configured in the Management Console > Application 
Configurations > Workflow Portal > Graphic Settings.)

Up to 5 branding layers are allowed; the configuration can be configured to allow 
operator selection of any or all layers. 

In this example, note that layers have logical names, may or may not be assigned a 
default graphic file, and may or may not permit the operator to select a file on a job-by-
job basis. 

Applying Branding Graphics
To add branding to a segment, display the Segment List tab. 

Select the segment and check the graphics layers you want to add. 

Up to 5 layers can be added, as specified in the Tempo Portal configuration. You can 
apply this branding to any segment or segments you choose.

You can also apply branding logos or specifications automatically, by setting up a pre-
ingest workflow and use Post Producer to burn in your branding as required.
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Specifying Tempo Settings
The Tempo Settings panel (with features described in the table below) allows you to set 
options related to caption processing and timecode in the re-timed output file.

Controls may be modifiable or read-only, depending on the configuration. Some 
controls may not display at all, if the configuration has been set to disable that feature.

The options and settings are described in the following table.

Controls Functions

Preserve and re-time 
captions

Selects whether to include and re-time captions 
together with the re-timed media. Applies to 
embedded captions and caption files.

Use subtitle/caption file Check Use subtitle/caption file to include a caption 
(.SCC) or subtitle (.STL) file that plays with the re-
timed output media file instead of pulling captions 
from the source. 

Note: The start timecode in the caption/subtitle 
file must match the start timecode of the media 
file.

Subtitle/Caption file When using a subtitle/caption file, enter the fully-
qualified path or click Browse to select the file.
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Subtitle/caption offset 
sign

Adjusts the start time of captions forward (+) or 
backward (-) relative to the specified starting 
timecode in the SCC or STL file. Use the offset 
feature described below to set the offset amount.

Subtitle/caption offset To adjust caption/subtitle file timecode start, select 
Subtitle/caption offset, enter the amount of offset in 
timecode, and set Subtitle/caption offset sign (+ or -
) to adjust the offset forward or backward.

Sets the amount of start time adjustment to apply 
to captions or subtitles relative to the start time 
specified in the caption or subtitle file.

Set timecode at Sets the starting or ending point of timecode in the 
re-timed media output file:

• Preserve source timecode (default): Use the 
timecode in the source media (first frame time-
code in the output will match first frame time-
code in the source). If no timecode is present in 
the source, zero start timecode is used.

• First frame of program: Start timecode at the 
first frame of the program (first frame of first 
segment marked “Segment is part of pro-
gram”).

• Last frame of program: End timecode at the 
last frame of the program (last frame of last 
segment marked “Segment is part of pro-
gram”).

• First frame of output file: Start timecode at the 
first frame of the media output file.

• Last frame of output file: End timecode at the 
last frame of the media output file.

When you select first or last frame, timecode 
settings open to let you set the timecode value. 

Controls Functions
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Configuring Timeline Settings
The Timeline tab provides settings to control the functionality of the Silence buttons on 
the Preview panel timeline. 

Silence level threshold—Sets the level for detecting silence. Default: -40db.

Silence duration minimum—Sets the minimum number of frames defining a period of 
silence. Default: 1 frame.

Artifact Quality Threshold—Sets the threshold for detecting artifacts and inclusion of 
artifact markers in the timeline. Default: 100%. If this value is set higher than the 
maximum specified in the quality report, the value in the quality report prevails and 
this value is ignored.
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Configuring the Segment List
As segments are created, view them in the player and mark their in and out points to 
assemble a complete program. To locate in and out points, use the player scrubber. The 
in/out timecode displays for the selected segment update automatically as you scrub.

 Segment List Overview

 Applying Advanced Tempo Settings

Segment List Overview 
The Segment List provides the palette for assembling your re-timed program. You drag 
the binder into the Segment List tray and duplicate it (right-click Duplicate) to divide it 
into multiple segments. 

The segment list features are described in the table following.

Note: If you used an Analyze action with Black Detection, Scene Change Analysis, and 
Slate/Spot Analysis to generate a segment analysis report, the report is processed 
when you drag the binder into the segment list. For each segment in the report, a new 
segment is created, reducing operator workload.

The Segment is part of program check box allows you to include or exclude a segment 
from the total running time calculation of the clip. New excluded segments are added 
to the end of the segment list by default. To reorder segments, right-click the segment 
list and select Sort List by Mark In. This places listed segments in order by Mark In time.

Use the Re-time this segment control to include or exclude the segment from re-timing. 

Use the Rating Graphic at Start control to include or exclude a rating graphic at the start 
of this segment.

The Advanced button displays a dialog with advanced settings (see Applying Advanced 
Tempo Settings) that override the Tempo action settings in the publishing workflow.
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Controls Functions

Add segment (+) Click + to copy the selected binder from the Catalog 
to the Segment List. You can also drag and drop. 
When marking segments on the timeline, scrub to 
the desired position for a new segment, and click + 
to add a new segment marker to the timeline. This 
also adds a matching segment to the list with Mark 
In set to the position of the new segment marker.

Delete (X) Click to delete the selected segment.

Up arrow Click to move the selected segment up in the list.

Down arrow Click to move the selected segment down in the list.

Mark In Mark the in point in the selected segment by direct 
entry, by using the arrows, or by scrubbing in the 
player, and pressing Mark. 

Mark Out Mark the out point in the selected segment by 
direct entry, by using the arrows, or by scrubbing in 
the player, and pressing Mark.

Go to Click to set the player position of the selected 
segment to the current Mark In or Mark Out point 
(shown in the timecode display).

Duration Set the duration of the selected segment by direct 
entry. Automatically displays duration as Mark In 
and Mark Out are changed. 

Segment description Enter a text description of the segment (optional).

Segment is part of program Check to include the selected segment(s) in the re-
timed program.

Re-time this segment Check to re-time the selected segment(s).

Rating graphic at start Check to display the rating graphic during the 
selected segment. The rating is set up in the 
Management Console portal configuration.

Branding Graphics (one per 
enabled layer)

When up to 5 content branding layers and their 
branding graphic are specified and configured in 
the Tempo configuration, they display here. Check 
to display a specific branding graphic during the 
selected segment.

Use Subtitle/Caption File When Preserve and Re-time Captions is specified 
and configured in the Tempo configuration, this 
option displays here. Check to use the specified 
caption file during the selected segment.
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Managing and Merging Segments
Automatic segment creation often results in extra segments that need to be manually 
deleted. However, deleting segments causes gaps or overlaps in the timecode of the 
remaining segments. 

Gaps and overlaps in adjacent segments are indicated by yellow warning highlights of 
the Mark In/Out labels, and an explanatory tooltip appears when you hover over the 
labels. For excluded segments, only overlapping timecodes generate this warning. 

One way to resolve gaps and overlaps is by re-marking the in and out point of each 
affected segment. This will clear the yellow highlights, but it’s time-consuming. 

Alternatively, you can merge multiple segments into a single segment. When merged, 
the segment timecode Mark In is set to the first selected segment Mark-In, and Mark-
Out is set to the last selected segment Mark-Out.

To merge segments, use Ctrl/Shift-click to select multiple segments, and right-click on 
Merge Segments. The following dialog opens.

Check boxes allow you to specify handling of program inclusion/exclusion and re-timing:

• Segment is part of Program—check to include the merged segment in the program.

• Re-time this segment—check to re-time the merged segment.

Note that excluded segments cannot be merged.

When you finish re-marking or merging all segments affected by gaps or overlaps, the 
yellow warning indicators on the mark labels will be eliminated.
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Applying Advanced Tempo Settings
Advanced Tempo Settings (Advanced button in Selected Segment panel) allow the 
operator to override the target workflow’s Tempo action advanced source video and 
audio settings, and re-timing methods on a per-segment basis.

These settings are the same as the Tempo Settings in the Tempo action, except for a 
few missing controls that are not applicable here. Refer to Configuring Tempo Settings in 
the Tempo Workflows chapter later in this guide for details.
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Adjusting Total Re-timing
Use the Re-time panel to specify how to re-time a program, and by what amount. 

After setting up the overall program by marking segments, select whether to re-time by 
changing the total program duration to a specified new duration or by increasing or 
decreasing the duration by an amount of time. Then enter the new duration or the 
amount of change by direct entry in the timecode display.

If the Change value is green or yellow after you set the duration/amount, your program 
is ready for re-timing. If the Change line is red, you must alter the duration/amount 
within allowed limits.

Controls Functions

Re-time Select how to re-time:

Set total duration: Re-times a clip to match the duration 
specified in Amount.

Set percentage: Re-time the clip by the percentage specified.

Increase duration by: Increase by the Amount specified.

Decrease duration by: Decrease by the Amount specified.

Duration/Amount/
Change

Specify the overall duration or the amount of duration change 
by timecode direct entry, or set overall percentage change.

Timecode displays Original duration: Original clip total duration. (Not including 
segments that have Segment is part of program unchecked.)

Eligible segments: Total duration of segments being re-timed.

Re-timed duration: Projected total duration of segments 
selected for re-timing after re-timing is done.

Change: Percentage of duration increase or decrease. Green 
(<9%) and yellow (>9%) indicates an acceptable percentage. 
Red indicates 10% or higher, which exceeds the limit. Change 
the re-timing duration/amount.
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Forwarding to Workflows
The Forward to Workflows tab and panel (described in the table following) lets you 
select re-timing workflows to which you can submit your finished re-timing project.

This panel is not displayed if Show Forward to Workflows is unchecked in the 
Management Console Tempo configuration. In that case, the Submit button is on the 
main panel.

1. Check the workflows to which you want to submit media for re-timing, and press 
the Submit button. In a two-pass configuration, select the first pass or second pass 
workflow, as appropriate.

2. Make any Metadata Label changes in the Submit Jobs window.

3. Press Submit in the Submit Jobs window. 

The workflows must be activated and ready to process, and they must include Receive 
and Tempo actions as described in the Tempo Workflows chapter. Otherwise, an error 
message indicates that the workflow is not running or doesn’t exist.
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Controls Functions

Add Metadata Label Allows labels to be added to the binder, if 
permitted by the Workflow Portal configuration. 
Click Browse to select the label to add.

Delete (X) Select a label from the list and click Delete to 
delete a label.

List and Parameters Added labels appear in a list on the left, and their 
parameters appear on the right.

Categorize Click to expand categories in the label parameters 
list. Click again to close.

Submit Submits the project to the selected workflows.
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Using the Two Pass Feature
The Tempo Two Pass feature enables you to re-time media in two passes through two 
different workflow stages to achieve very high-quality re-timing results. These are the 
general steps for performing Two Pass re-timing:

1. Before the two re-timing passes can be performed, you must run an ingest 
workflow that registers the media, proxy, and thumbnail in a Pass 1 catalog. The 
catalog can be named anything, but using the “Pass 1” name serves as a reminder 
that this catalog is used for the first re-timing pass.

2. In the Tempo Portal, review the Pass 1 catalog binder, and mark segments for re-
timing in the same way as for single-pass re-timing projects described earlier in this 
chapter.

3. Submit the media you have marked in the portal to the first pass (ingest) workflow 
using Forward to Workflows. For convenience, you might call this workflow Pass 1.

The Pass 1 workflow includes a Tempo action that is set to Multi Pass/1st Pass. This 
action performs initial re-timing and outputs a re-timed Tempo Intermediary TIFO 
file. The action also produces a Tempo Quality Report that identifies segments that 
may display quality artifacts resulting from re-timing. 

Additionally, this workflow can include an Analysis action to perform Scene Change 
Analysis and feed it to the second pass workflow so that scene changes can be 
automatically detected and displayed on the preview player timeline. Files pro-
duced by the Pass 1 workflow, including the re-timed media, proxy, Tempo Quality 
Report, the original CML, and scene Analysis Result attachment are stored in a Pass 
2 catalog for review by the Tempo Portal Operator and use in the second pass.

4. In the Tempo Portal, create a New Project to clear your first pass selections, and 
then view the Pass 2 catalog which includes the first-pass re-timed media and files. 
The scene changes and quality artifacts in the first-pass are shown on the timeline. 
Additionally, the Segment List will have changed names to an Exclusion Segment 
List that lists all segments containing re-timing artifacts where the quality is below 
the Quality Threshold set in the Pass 1 Tempo action. 

5. Notice the timeline features described below. The orange artifact markers indicate 
places that did not meet the re-timing quality threshold in Pass 1. You can then mark 
the scenes containing those artifacts to be excluded from re-timing in Pass 2.

– Timeline markers:

Orange - Artifacts 

Green - Scene changes

– Timeline buttons:

Scene

Artifacts

Silence

– Jump between artifacts and scene changes by pressing the corresponding buttons.

– Jump between silence points, open the Timeline tab and note silence detection settings.
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– Note that excluded segments are best created on scene changes with low audio 
levels, when possible. Creating excluded segments when the audio level is high 
may result in momentary audio glitches.

– Note that as opposed to a 1st pass binder, the Segment List tab is now called 
Excluded Segment List. Scenes you add to this list will be excluded from re-timing.

6. Look through the segments in the Exclusion Segments List in the preview player 
and possibly delete any that are acceptable visual quality or manually add other 
segments to the list that you feel should be excluded from re-timing to improve 
quality. The purpose of this second pass in the Tempo Portal is to exclude all 
segments that exhibit unacceptable quality so that a second re-timing pass will not 
touch those segments, resulting in a higher quality final re-timed output.

7. Use Forward to Workflows to submit the media you have just marked up for re-
timing again in the Pass 2 workflow. Your Exclusion Segment List is converted to an 
Exclusion CML, which is automatically processed with all the other files from the 
Pass 1 workflow to do a second re-timing of the media.

8. When the Pass 2 workflow completes, the re-timed output file can be found in the 
Vantage Store specified in the workflow. The re-timed media does not re-time any 
of the scenes you marked for exclusion after Pass 1. This should produce a re-timed 
output in which all scenes are above the Quality Threshold set in the Tempo action. 

For additional information about using the Two Pass feature, see the Tempo Workflows 
chapter in this guide. You may also want to refer to the demo video and accompanying 
Vantage App Note called “Using Tempo Two Pass” on the Telestream.net web site. 

http://www.telestream.net
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Tempo Portal Menus
This table describes the menu selections in the Tempo Portal.

Menu Selection Description

File Change Vantage Domain Displays a window for selecting a domain 
from all the domains on the network.

Recent Domains Shows recently accessed domains in a 
menu for selection.

Change/Reload 
Application Configuration

Displays a window for selecting a Workflow 
Portal configuration.

Exit Closes the Tempo Portal program.

New Project Clears the clip and segment list to start a 
new project.

Open Project Opens a previously saved project file and 
places the Portal in the state the project 
was in when it was last saved.

Save Project

F11

Re-saves the current Portal project. Also use 
F11 to re-save existing projects. 

Save Project As

F12

Saves the current Portal project in XML 
format in the location you specify. Also F11 
saves new projects as, or F12 saves existing 
projects as.

View Half Size Video Sets preview video scale to 50%.

Normal Size Video Sets preview video scale to 100%.

Double Size Video Sets preview video scale to 200%.

Scale Video to Fit Scales preview video to fit the window.
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Options Restore Tips & Warnings Restores Portal tips and warnings display 
after the feature has been disabled.

Hide Tips & Warnings Hides Portal tips and warnings.

Prompt for Login Next 
Time Application is 
Launched

When checked, the Portal requires login 
each time the program is launched, to 
increase security.

Use Clip Start Time When checked, the preview window uses 
the start time defined in the proxy media. 
When unchecked, the start time is zero.

Display Audio Levels Turns audio level bars on and off, along the 
sides of the preview window.

Display Segment Markers Shows/hides the segment markers (white) 
on the timeline in the player.

Display Scene Change 
Markers

Shows/hides the scene change markers 
(green) on the timeline in the player.

Display Artifact Markers Shows/hides markers identifying re-timing 
artifacts for operator inspection

Display Marker Navigation 
Buttons

Shows/hides the Marker Navigation 
buttons

Enable Mark In Keyframes Enables/disables generation of segment 
specific keyframes on a Mark In.

Enable Preview Player 
Timeline Expansion 

Enables/disables timeline expansion 
feature

Help Contents Displays the help guide.

Index Displays the index of the help guide.

Search Searches for key words in the guide.

Tempo Portal Help Displays the Tempo User Guide.

Online Help Displays the Vantage guides available on 
the Telestream web site.

About Displays the Portal version information.

Menu Selection Description
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Tempo Context Menu
This table describes the context menu commands in the Tempo Portal Segment List.

Selection Description

Copy Mark In Copies the Mark In value of the selected segment.

Copy Mark Out Copies the Mark Out value of the selected segment.

Paste Mark In Pastes a copied Mark In value to the selected segment.

Paste Mark Out Pastes a copied Mark Out value to the selected segment.

Copy Mark Out to Mark In Enabled when multiple segments are selected. For all 
selected segments, it replaces the Mark In time with the 
Mark Out time of the preceding segment.

Copy Mark In to Mark Out Enabled when multiple segments are selected. For all 
selected segments, it replaces the Mark Out time with 
the Mark In time of the next segment.

Sort List by Mark In Sorts the Segment List by Mark In values.

Copy Segment Metadata Copies the metadata of the selected segment.

Paste Segment Metadata Pastes copied metadata to the selected segment.

Duplicate Creates a copy of the selected segment.

Merge Segments Merges multiple segments selected by Ctrl-click or Shift-
click.

Move Up Moves the selected segment up one position in the list.

Move Down Moves the selected segment down one position.

Delete Permanently removes the selected segment. 
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Tempo Workflows

This chapter presents prototype Tempo workflows that you can implement to give you 
a head start in deploying Tempo in your environment.

Two workflows are required for a minimal Tempo workflow to re-time media:

 Tempo Ingest Workflow—ingests media, creates proxy and thumbnail files, and 
registers the files into the catalog used in the Tempo Portal. Optionally, black and 
slate/spot/color bar segments are identified, and a metadata label is created.

 Tempo Re-Timing Workflow—often called a publishing workflow in all Workflow 
Portal applications—ingests the Portal-generated composition that identifies the 
source asset to re-time and provides re-timing instructions. This workflow 
transcodes a re-timed media file.

Additionally, the Tempo Two Pass feature allows you to process media in multiple 
passes to achieve very high quality re-timing results.

 Tempo Two Pass Re-timing Workflows allow you to re-time the media in stages for 
best results.

Note: Beginning with Vantage 8.0 UP1 with Tempo ComponentPac 8.0.1, the Tempo 
action is available in the Telestream Cloud. Refer to the Vantage Cloud Port User Guide 
for details about using the Tempo action and other Vantage actions in the Cloud. 

Note: Before you can implement the workflows you will create here, you must create 
Tempo Portal configurations and set up other resources as explained in the chapter, 
Configuring Tempo Resources. In particular, to take advantage of the Tempo Two Pass 
feature, configure all resources as explained in that chapter, and then create Portal 
configurations as described in Creating Two Pass Portal Configurations.
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Tempo Ingest Workflow
Before media files can be reviewed and segmented for re-timing using Tempo Portal, 
they must first be processed by an ingest workflow to these operations:

• Ingest the source media file in a target directory monitored by a Watch action or 
manually submitted to the workflow starting with a Watch or Receive action

• Optionally, analyze source for Black Detection, Scene Change Analysis, and Slate/
Spot Analysis.

• Optionally, analyze source and extracts specific metadata into a label

• Create a proxy from the media file (required) and create a thumbnail (optional)

• Register the source media file into a catalog along with the output from the work-
flow: thumbnail, proxy, metadata, segment report, etc.

Any workflow can be used as an ingest workflow, if receives a source media input file, 
creates a proxy file, and registers the output into a catalog. Optionally, the ingest 
workflow can be configured to analyze the source media to extract metadata, and for 
Black Detection, Scene Change Analysis, and Slate/Spot Analysis, which can be 
automatically created in Workflow Portal, reducing operator workload.

Vantage Tempo can utilize these types of files in Tempo Portal:

• Segment Analysis Report—generated for use in automatically creating Black Detec-
tion, Scene Change Analysis, and Slate/Spot Analysis segments in Workflow Portal.

• Proxy—a small, QuickTime duplicate of the source file that is used to scrub video:

• Create a QuickTime H.264/AAC MOV proxy file or an MP4 x264/AAC proxy file (with 
a timecode track included in the container for QuickTime only). 

– The encoded proxy file must have the same frame rate and timecode notation as 
your source media. The frame should be the same ratio, smaller for scrubbing 
(and encoding speed).

– For SD proxies (4:3) use a 640 x 480 frame size. For HD proxies (16:9) use 640 x 360. 

– Assign the nickname Vantage Proxy, which the player automatically recognizes. 
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• Optional Thumbnail—a JPEG keyframe snapshot in the source file displayed in the 
Tempo Portal Catalog binder list to visually represent the binders. Consider grab-
bing a keyframe several seconds into the source.

• Metadata Label—which can be populated with metadata extracted from the source 
so that you can pass the metadata to a publishing workflow for use there.

Watch Action
 Configure the Watch action (in the Monitor category) to ingest the source media file 
from a watch folder.

Analyze Action
The Analyze (from the Analysis category) action automates detection and analysis of 
black, slate and spot and color bars, as well as scene changes and analysis of Telecined 
material and its characteristics.

This aids in metadata extraction and automatic segment generation. Depending on 
your requirements, configure an Analyze action with these optional tools as follows:

• In the Analyze Settings for the action, check Generate Analysis Result Attachment 
and specify Analysis Result as the file nickname (required). This file will contain data 
for each tool you add. In Workflow Portal, when you drag media into your segment 
list, the data is used as appropriate, depending on the type of segments you decide 
to auto-generate.

• Media Properties tool— Enable Video Width, Video Height, and Video Framerate, 
assigned to variables of the same name. This metadata is added to a metadata label 
for passing to a publishing workflow for use in the Tempo action for transcoding.

• Black Detection tool—to identify black segments; typically you can use the default 
configuration except under General, where you should disable Consider Audio. For 
special circumstances, configured per your requirements.

• Slate/Spot Analysis tool—to identify slate, spot, and color bars segments; typically 
use the default configuration except under General, where you should disable Con-
sider Audio. For special circumstances, configured per your requirements.

The results of the black and slate/spot detectors (timecode and duration) are stored 
in the report to automatically create these segments in Workflow Portal.

• Scene Change tool—to identify scene changes and identify them as segments; typi-
cally, use the default configuration. For special circumstances, configured per your 
requirements.

• Telecine Detection tool—to identify scene changes and identify them as segments; 
typically, use the default configuration. For special circumstances, configured per 
your requirements.

• Telecine Cadence Analysis—to detect breaks or changes in Telecined content, to 
determine the cadence(3322/3232), field order, starting phase, and position of the 
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first repeated position in the cadence. The filter can detect both a 3:2:3:2 and a 
3:3:2:2 cadence within the source media. 

Check for each metric to collect, and assign a variable. Then, add a Populate action 
and create a label with these variables as parameters, to be used in the publishing 
workflow (which must be modified to accept the label and use the parameters.) In 
Tempo, if your Source Video Type is set to Telecined 60i (Unedited, with Fixed 
Known Cadence), you can bind the value of the First Repeated Field Position to the 
appropriate variable from the ingest workflow. 

Flip Actions
Two Flip actions (located in the Transcode category) transcode the incoming media file 
into a QuickTime or MP4 proxy file for scrubbing, and a keyframe JPEG image to use for 
the thumbnail view. 

Proxy Flip Action
This Flip action generates the proxy file. It should be configured as follows:

• Create a QuickTime H.264/AAC MOV proxy file or an MP4 x264/AAC proxy file.

• The encoded proxy file must have the same frame rate and timecode notation as 
your source media. 

H.264 Video—For the Frame Width/Height/Frame Rate, and Frame Rate settings, 
bind them to the variables you specified in the Analyze action. (You could also add 
a Compute action to correctly reduce the size of the frame retaining the correct 
frame ratio.) Alternatively, for SD proxies (4:3) use a 640 x 480 frame size. For HD 
proxies (16:9) use 640 x 360. 

• Assign the nickname Vantage Proxy, which the player automatically recognizes. 

Thumbnail Flip Action (Optional)
This Flip action that generates the thumbnail, and should be configured as follows:

• Use the Keyframe encoder to create a single JPEG keyframe. 

• Assign the nickname Vantage Thumbnail, so that they display in the Catalog panel 
in Workflow Portal. 

Populate Action
The Populate action (located in the Metadata category) should be configured to create 
an Identify label and add Video Height, Video Width, and Framerate fields. This label 
will be passed to the publication workflow for encoding the asset using the same 
metrics.
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Register Action
The Register action (from the Catalog category) registers the binder assets (original, 
proxy, label, analysis report, and keyframe thumbnail) in a Tempo catalog (which must 
have been created previously).
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Tempo Re-Timing Workflow
A simple, prototype Tempo workflow is shown here. At a minimum, a Tempo re-timing 
workflow must contain these actions:

• A Receive action to ingest the composition file from Tempo Portal and start the job

• A Tempo action to re-time the source media, producing a re-timed output media file.

Receive Action
The Receive action (located in the Common category) is configured to receive the 
composition file (CML) you submitted from the Portal. Expected Nicknames must be set 
to CML as shown below.

Also, select the Identify Label under Labels.

Populate Action
Use the Populate action (from the Metadata category) to extract the metadata from the 
Identify label (Variables from Label Parameters) and assign the values to the same 
variables again, for use in the Tempo action during encoding.

Tempo Action
Use the Tempo action (from the Edit category) to re-time the media file and adjust the 
running time of the segments as specified.

Note: This is not a topic on how to configure every control in the Tempo action. 
Complete details for configuring Tempo (or any other action) are presented in the man 
page—in the inspector, click the M icon in the upper right corner.

The following controls should be configured as required.

Input File Nickname—Must be set to CML. (The CML nickname must also be set as the 
output from the Receive action). 

Generate Composition Chronicle—Typically, leave unchecked.

Composition Chronicle Location—Specifies where to output the composition file.

Transcoders—Add one or more Transcoders using the Add Transcoder (Plus sign) icon at 
the right side of the Transcoders panel. One video transcoder may be added, and up to 
32 audio transcoders. 
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Select the codec and configure it, and then select the transcoder, and configure it. 
Different configuration options appear, depending on whether the codec or transcoder 
is selected (as shown in the figure following). These options allow you to set the 
resolution (width, height, framerate, aspect, interlace), frame type, captioning, content 
advisory, active format description, and copy limitations).

Output—Add output video and audio streams by checking stream boxes. Select the 
media (container) type for the streams using the Select menu in the right upper corner 
of the Output panel, and specify the Output Location for the encoded file using the 
Output button. You can also edit the file name using the Edit Filename button. 
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To view and configure the output container, click the overall output area and make 
selections in the right panel. To view each video or audio output stream, click the 
particular stream inside the container and view its listing in the right panel. 

Using Video Processors
Video Processors are available in the Tempo action to add an Image Processing Filter or 
a Color Space Filter. You can create and save multiple Video Processor templates with 
different processing selections, making for easy repeatability of particular 
configurations whenever you need them.

If you use Video Processors in the Tempo action, you must modify the Tempo CML file 
produced by the Tempo Portal before submitting it to a Tempo workflow. See the 
Processors section of the Tempo Action topic (on the following pages).

Processors—You can create as many video processor templates as necessary using the 
Plus icon at the right side of the Processors panel. Configure filters for the templates in 
the right panel. 

Note: Using the Video Processors requires manual adaptation of the composition file 
produced by the Tempo Portal before submitting the file to a Tempo workflow. 

To configure Video Processor templates and modify the composition, perform these 
steps:

1. Click the + (add) button in the Tempo action Video Processors section.

2. Enter a name for the processor in the field that says, “Enter template name.”

3. Click the new processor to highlight it, and make filter selections in the right panel.

4. Open the CML file generated by the Tempo Portal. 

5. In the Video Source block, add this line for each processor (up to 2):

<Processor template=“template name”/>

The template name is the name you gave the Video Processor template in the 
Tempo action Inspector (step 2 above).

Here is a snippet of CML code as an example:
<Source identifier="1764957960" timecode="ltc">
<File location="\\share\path\media_file.mov" />
<Subtitle preserve708="false" />
<Processor template="VidProc1" />
<Processor template="VidProc2" />
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</Source>

Configuring Tempo Settings
The Tempo Settings panel allows you to set up Tempo action advanced source video 
and audio settings, and re-timing methods.

Open each sub-panel to display and configure the settings.

Source Video Type

Specifies the source video type, selected from the menu. 

Auto—causes Tempo to auto-sense the source video type. Output quality may be 
enhanced by selecting a specific type, if it is known. Progressive sources are treated as 
progressive. Interlaced sources are treated as interlaced; however, interlaced sources at 
29.97 fps are treated as mixed (see description below). If the entire source is known to 
be interlaced 29.97 fps, select Interlaced rather than Auto.

Progressive—Sources are treated as progressive even when encoded as interlaced.

Telecined 60i (Unedited, with fixed known cadence)—Sources are treated as Telecine, 
unedited, with known cadence and first repeated field position. The fields for cadence 
type and first repeated field position must be set correctly for correct rendering of the 
video output. The output is Telecined.

Supply the following values:

Telecine Cadence Type—Specifies the Inverse Telecine cadence to use: 3223 | 3322.

First Repeated Field Position—Specifies the position of the first repeated field.
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Telecined 60i (Unedited, with fixed unknown cadence)—Sources are treated as Telecine, 
unedited, but with unknown cadence and/or first repeated field position. With this 
selection, cadence is automatically determined with the first strong cadence. This 
option should not be selected if there are any changes in the Telecine cadence of the 
source. The output is Telecined.

Telecined 60i (Edited)—Sources are treated as Telecine, with possible edits and cadence 
changes. This option should be selected if there are any changes in the Telecine 
cadence of the source. The output is Telecined.

Telecined 60p (Unedited, with fixed known cadence)—60p (59.94 progressive) sources are 
treated as Telecine, unedited, with known cadence and first repeated field position. The 
fields for cadence type and first repeated field position must be set correctly for correct 
rendering of the video output. 

Supply the following values:

Telecine Cadence Type—Specifies the Inverse Telecine cadence to use: 3223 | 3322.

First Repeated Frame Position—Specifies the position of the first repeated frame.

Telecined 60p (Unedited, with fixed unknown cadence)—60p (59.94 fps progressive) 
sources are treated as telecined, unedited, but with unknown cadence and/or the first 
repeated frame position. With this selection, cadence is automatically determined with 
the first strong cadence. This option should not be selected if there are any changes in 
the Telecine cadence of the source.

Supply the following values:

Cadence Detection Sensitivity (Default: 50)—Specifies the point at which film 
cadence is detected. In almost all the cases, cadence sensitivity should be left at its 
default value. Setting to a lower value decreases sensitivity and should only be 
used if cadence changes are erroneously detected in places where cadence is sta-
ble. Setting to a higher value increases sensitivity and should only be used if 
cadence changes are not being detected.

Telecine Cadence Type—Specifies the Inverse Telecine cadence to use: 3223 | 3322.

Telecined 60p (Edited)—Progressive sources are treated as Telecine, regardless of 
whether there are edits or cadence changes. The output is progressive.

Supply the following values:

Cadence Detection Sensitivity (Default: 50)—Specifies the point at which film 
cadence is detected. In almost all the cases, cadence sensitivity should be left at its 
default value. Setting to a lower value decreases sensitivity and should only be 
used if cadence changes are erroneously detected in places where cadence is sta-
ble. Setting to a higher value increases sensitivity and should only be used if 
cadence changes are not being detected.

Telecine Cadence Type—Specifies the Inverse Telecine cadence to use: 3223 | 3322.

Telecined 30p (Unedited, with fixed known cadence)—30p (29.97 fps) sources are treated 
as Telecine, unedited, with 1:1:1:2 cadence and known first repeated field position.
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Supply the following value: 

First Repeated Field Position—Specifies the position of the first repeated field.

Telecined 30p (Unedited, with fixed unknown cadence)—30p (29.97 fps) sources are 
treated as telecined, unedited, with 1:1:1:2 cadence but with an unknown first repeated 
frame position. With this selection, cadence is automatically determined with the first 
strong cadence. This option should not be selected if there are any changes in the 
Telecine cadence of the source.

Supply the following value:

Cadence Detection Sensitivity (Default: 50)—Specifies the point at which film 
cadence is detected. In most cases, cadence sensitivity should be left at its default 
value. For high quality sources, setting to a lower value decreases sensitivity and 
should only be used if cadence changes are erroneously detected in places where 
cadence is stable. Setting to a higher value increases sensitivity and should only be 
used if cadence changes are not being detected. For lower quality sources, this 
value can be adjusted downward to prevent cadence-related errors. A typical value 
for a highly macro-blocked, low-quality source would be 25. Sources with light 
macroblocking work best at 40. 

Telecined 30p (Edited)—30p (29.97 fps) sources are treated as Telecine, with possible 
edits that may interrupt the expected cadence pattern.

Supply the following value:

Cadence Detection Sensitivity (Default: 50)—Specifies the point at which film 
cadence is detected. In most cases, cadence sensitivity should be left at its default 
value. For high quality sources, setting to a lower value decreases sensitivity and 
should only be used if cadence changes are erroneously detected in places where 
cadence is stable. Setting to a higher value increases sensitivity and should only be 
used if cadence changes are not being detected. For lower quality sources, this 
value can be adjusted downward to prevent cadence-related errors. A typical value 
for a highly macro-blocked, low-quality source would be 25. Sources with light 
macroblocking work best at 40.

Interlaced—Sources are treated as interlaced, even when the source is encoded as 
progressive. The output is interlaced.

Mixed—Sources are assumed to have broken cadence and may also include interlaced 
and progressive fragments. For example, a Telecined source with interlaced or 
progressive commercial inserts. Specify Telecine Cadence Type, Cadence Detection 
Sensitivity, and Ltr Propagation.
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Telecine Cadence Type—Specifies which cadence of interlaced Telecine will be used: 

Auto—Handles 2:2 (PsF), 3:2:3:2, 3:3:2:2, 1:1:1:2, 2:2:2:4 cadence, progressive and 
interlaced video. 
22—can be used for predominantly 2:2 (PsF) sources and if selecting Auto produces 
unsatisfactory results.
3232—can be used for predominantly 3:2:3:2 sources and only if selecting Auto or 
using Telecine (Edited) video source type produces unsatisfactory results. 
3322—can be used for predominantly 3:3:2:2 sources and only if selecting Auto or 
using Telecine (Edited) video source type produces unsatisfactory results.
1112—can be used for predominantly 1:1:1:2 sources and only if selecting Auto or 
using Telecine (Edited) video source type produces unsatisfactory results.
2224—can be used for predominantly 2:2:2:4 sources and only if selecting Auto or 
Telecine (Edited) video source type produces unsatisfactory results.

Cadence Detection Sensitivity (Default: 50)—Specifies the point at which film cadence is 
detected. In almost all the cases, cadence sensitivity should be left at its default value. 
Setting to a lower value decreases sensitivity and should only be used if cadence 
changes are erroneously detected in places where cadence is stable. Setting to a higher 
value increases sensitivity and should only be used if cadence changes are not being 
detected.

Ltr Propagation—Enables low-temporal-rate motion profile propagation in high-
temporal-rate output. For instance, PsF frames will be converted to PsF instead of 
interlaced. This may hep to reduce a pulsing effect in the video, when processing noisy 
sources.

Video Retime Method

Advanced Motion Compensation—Specifies that Tempo should apply a specific motion-
compensation algorithm to re-time the video.

Cadence Modulation + Advanced Motion Compensation—Applies only to Telecined or 
Mixed sources. Fragments without cadence are processed by Advanced Motion 
Compensation. When checked, source frames are retimed as follows:

For encoders configured to output interlaced video:

60i source fragments with 3:2:3:2 or 3:3:2:2 cadence result in altered 3:2:3:2 cadence 
after re-timing.

60i (30p) source fragments with 1:1:1:2 cadence result in altered 3:2:3:2 cadence 
after re-timing.

60i true interlace source fragments result in true interlace frames after re-timing 
obtained by applying advanced motion compensation.

Progressive (or PsF) source fragments result in true interlace frames after re-timing 
obtained by applying advanced motion compensation.
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For encodes configured to output progressive video:

60i source fragments with 3:2:3:2 or 3:3:2:2 cadence will result in altered 1:1:1:2 
cadence after re-timing.

60i (30p) source fragments with 1:1:1:2 cadence will result in altered 1:1:1:2 cadence 
after re-timing.

60i true interlace source fragments will result in progressive frames after re-timing 
obtained by applying advanced motion compensation.

Progressive (or PsF) source fragments will result in progressive frames after re-tim-
ing obtained by applying advanced motion compensation.

60p source fragments with 3:2:3:2, 3:3:2:2 and 2:2:2:4 cadence will result in altered 
3:2:3:2 cadence after re-timing.

HQ Blend—Applies only to progressive and interlaced video. For interlaced video, 
specifies that Tempo should de-interlace the video using Advanced Motion 
Compensation, blend the sources according to the re-time settings, and then re-
interlace the video. For progressive video, the sources are simply blended according to 
the re-time settings.

Supply the following value:

Use Original Frame if Within—Specifies the maximum percent (measured as a per-
centage of frame duration), for potential input frames to be considered as occur-
ring at the same time as the current output frame. If an input and output frame are 
very close together, the output frame will be supplied by the input frame, based on 
this limit.

Cadence Modulation + HQ Blend—Specifies that Tempo should use Cadence 
Modulation on frames with 3:2:3:2, 3:3:2:2, 1:1:1:2 or 2:2:2:4 cadence and HQ Blend on 
all other frames. This setting only applies when the Source Video Type is set to Mixed, 
and Telecine Cadence Type is set to Auto.

Adaptive—Specifies that Tempo should use Cadence Modulation on frames with 
cadence for mixed sources. Other frames are processed using Advanced Motion 
Compensation or HQ Blend based on quality metrics to minimize video artifacts. This 
setting only applies when the Source Video Type is set to Mixed | Interlaced | Mixed.

Nearest Neighbor—Applies only to progressive and interlaced video. Specifies that 
Tempo should select the closest input frame as the source for any output frame to re-
time the video. 

Advanced Video Settings

Source Frame Configuration—Select how you want the Tempo action to decode the 
input file. The field dominance selected in this advanced setting MUST match the 
output field order specified in the Transcoder resolution panel. Select Detect from 
Source File when you want the Tempo action to treat the input as normal for the type of 
essence in the input file, and also assume standard field dominance for interlaced 
media. If the media essence is not encoded in a standard way or there is a field 
dominance error for interlaced, select progressive, or interlaced with the dominance to 
use when decoding the input file.
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Output Frame Configuration—Specifies how you want Tempo to encode the output file.

Use Encoder Settings—Specifies that the Tempo action should treat the output as 
normal for the type of essence in the output file, and also assume standard field 
dominance for interlaced media.

Interlaced Upper Field First | Lower Field First | Progressive—If the media essence is not 
encoded in a standard way, you should select the appropriate setting for encoding 
the file. For instance, when using Cadence Modulation and encoding interlaced, 
but 1:1:1:2 cadence is desired in the output, select Progressive.

Blank Top | Blank Bottom | Blank Left | Blank Right—Specifies frame alteration by filling 
the specified lines / columns with black to eliminate flicker and artifacts. See tooltips for 
details.

Preserve VBI Start Line—Specifies the index of the first line of VBI to preserve. Relative to 
the Blank Top value and the Number of VBI lines value. For example, using a 720 x 512 
NTSC source, Blank Top is set to 32, Preserve VBI Start Line is 2, and Number of VBI Lines 
to Preserve is 2. In the output, the top 28 lines will be black filled; 2 lines of VBI will be 
preserved, and the final 2 lines again filled with black. See tooltips for details.

Number of VBI Lines to Preserve—Specifies the number of VBI lines to leave intact in the 
output frame. Relative to the Blank Top value and the Preserve VBI Start Line value. See 
example in previous control. See tooltips for details.

Noise Suppression Strength—Specifies the relative strength of the noise suppression 
process (0-100). Noise suppression is designed to prevent a pulsing effect in the 
apparent degree of noise in the output of re-timed noisy, native-interlaced sources. 

Number of Threads—Specifies the number of threads to use when re-timing (0-128). 
When set to zero, one thread per core is utilized. 

Align Segments to Full Second—Check to align each retimed segment to the nearest full 
second. When checked, all segments are set to full-second alignment. Fixed (non-
retimed) segments may also be retimed by up to 2 frames to account for DF timecode.

Processor. Select which video processor to use for transcoding.

Source Audio Type

Source Audio Type—Specifies Music | Speech as the audio type, so that the audio 
settings can be auto-adjusted for the specified type of audio in the media.

Advanced Audio Settings

Cross Fade Duration—Specifies the cross-fade duration between adjacent segments, in 
milliseconds.

Enable Pitch Correction—When checked, enables Tempo to automatically correct audio 
distortion introduced during processing. The likelihood of distortion increases as the 
rate of re-timing approaches the maximum allowable change. For operator-driven 
workflows, you can override the Tempo action setting, and allow the operator to set 
pitch correction on a segment-by-segment basis in Workflow Portal.
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Metadata

Allows generating retimed EBU STL files for up to three languages. The original file 
must be referenced in the source CML file. The files are associated with language 1, 2, 
and 3 output files ordinally. That is, the first file in the CML is associated with the 
Language 1 output file, etc.

Retimed STL Subtitles—When checked, specify the output file by file nickname or by 
fully-qualified path and file name.

Multi Pass 

Enables or disables (default) Two Pass re-timing (drop-down menu specifies that this 
action is disabled or being used in the 1st Pass or the 2nd Pass). 

Copy Action
The Copy action shown in the example is optional. The Copy action copies the re-timed 
output to any output location you prefer for broadcast or distribution.
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Tempo Two Pass Re-timing Workflows
The Tempo Two Pass capabilities build upon what is available in the standard Vantage 
Tempo capability by allowing refinement of the re-timing process in a second pass. The 
following pages explain Two Pass workflows, and a detailed example video and app 
note further describing Tempo Two Pass are available on the Telestream.net web site. 

With Tempo Two Pass you have the option of placing the Tempo action into one of the 
following Modes:

• Disabled—The default mode for a Tempo action re-times media in one pass. This 
option is not used for two-pass configurations. 

• 1st Pass—In this mode the Tempo action analyzes and detects issues or trouble-
spots with the first pass Tempo output. A Tempo action configured in the Pass 1 
mode produces a TIFO file (Tempo Intermediary) and a Tempo Quality Report 
metadata attachment file. This file corresponds to the points in the first pass Tempo 
output that are possibly unsuited for re-timing (because they were identified as 
areas which presented difficulties for the Time Compression algorithm). The media 
and report files are included in a catalog and binder that the Tempo Portal operator 
can select as source inputs to the Pass 2 workflow.

• 2nd Pass—In this mode, the Tempo action must be provided 1st-pass re-timed 
media and a Tempo Quality Report in the source catalog for the 2nd pass. A nick-
name must also be selected for an Exclusion CML. 

The Tempo Portal uses the information in the Tempo Quality Report to identify pro-
gram segments to consider for exclusion because they contain artifacts (places that 
do not meet a specified Quality Threshold). Additionally, the Tempo Portal allows 
the operator to view artifacts in a timeline view and in the Exclusion Segment List 
where scenes can be selected for exclusion. The scenes marked for exclusion are 
listed in an Exclusion CML automatically created by the portal.

The original CML and the Exclusion CML are supplied by the portal automatically 
when the portal operator submits the edited catalog to the 2nd Pass workflow. The 
Tempo action bypasses the excluded segments in the second pass, re-timing only 
those segments that will produce a high quality output. 

• The Tempo Two Pass approach requires proper setup of the following Vantage 
components:

– Workflows

– Portal

– Catalogs

http://www.telestream.net
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Configuring a Catalog for Two Pass
The Tempo Two Pass scenario requires two separate catalogs or one catalog containing 
two folders:

• Pass 1 catalog

• Pass 2 catalog

or

• Tempo Catalog

– Pass 1 folder

– Pass 2 folder

The Pass 1 catalog or folder is the target of an Ingest workflow that receives and 
registers the media to be re-timed. 

The operator accesses the Pass 1 catalog and binder in the Tempo Portal and submits it 
to the Pass 1 workflow for initial re-timing and analysis. The outputs of the Pass 1 
workflow get registered into the Pass 2 catalog.

The Pass 2 catalog and binder are accessed by the operator and prepared in the Tempo 
Portal for submission to the Pass 2 workflow, which produces the final re-timed output.
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Configuring Workflows for Two Pass
The following presents an overview of single pass and Two Pass re-timing:

A Tempo Ingest Workflow—This workflow brings the initial material into Vantage and 
registers it into the Pass 1 catalog, which allows it to be visible to a Tempo Portal 
operator. The operator accesses the catalog and binder in the portal, selects re-timing 
parameters, and submits it to the Single Pass or Pass 1 workflow for re-timing.

A Tempo Single Pass Workflow—This is the same one-pass re-timing workflow that 
has always been available in Tempo. The operator marks scenes for re-timing in the 
Tempo Portal and submits the marked catalog/binder to the Single Pass Workflow via 
the Forward to Workflows portal panel. The workflow, receives the catalog and an 
automatically generated CML markup file from the portal. A Tempo action follows the 
CML instructions to create a TIFO file, which is presented to a Vantage Transcoder (Flip) 
to render the final re-timed output. 

A Tempo Pass 1 Workflow—This is the first pass of a Two Pass Tempo workflow. The 
purpose of the first stage is to produce an intermediate output that identifies 
questionable sections not suitable for re-timing and to supply re-timed media from 
which to make a more refined submission using a second pass. 

The Pass 1 workflow creates a mezzanine TIFO file that can be passed to the next stage 
for further re-timing refinement or sent to a direct output workflow if the first-pass 
quality is satisfactory. This TIFO file is given the nickname Tempo Intermediary. The first 
stage may also include a Flip action to generate a new Vantage proxy from the Tempo 
Intermediary file, and possibly another Flip action to generate a thumbnail file for 
displaying the binder as a thumbnail in the portal. Optionally, the first pass Tempo 
workflow may include an Analyze action for Scene Change Analysis of the Tempo 
Intermediary output. Note that the Tempo, Analyze, and Flip actions in this workflow 
are ideal candidates for open workflows. A Register action places the outputs of this 
workflow into the Pass 2 catalog for later access by the Pass 2 workflow.

In the Tempo Portal, the Pass 2 catalog/binder contents are analyzed so that scene 
changes and re-timing artifacts can be displayed in the timeline and used to compile 
an Excluded Segments List. The operator can also mark additional segments on the 
timeline for adding to the list. When the operator submits the list to the Pass 2 
workflow, an Exclusion CML representing the Exclusion List is passed to the workflow 
along with the media to identify scenes NOT to be re-timed to avoid quality issues.

A Tempo Pass 2 Workflow—This is the final workflow that you will target if you have 
chosen a two-pass process. This workflow consumes the original CML created by the first 
pass through the Tempo portal, as well as the Exclusion CML media nickname that is 
generated by the second pass through the Tempo Portal. The Exclusion CML prevents re-
timing of scenes marked as unsuitable for re-timing. The Tempo action in the Pass 2 
Workflow emits a re-timed TIFO output that is then available for use as the final output, or 
it can be transcoded again into the desired final format. 

Tempo Direct Convert Workflow—This optional workflow may be used if the output of 
the Pass 1 workflow is of sufficient quality that it does not require a second pass. The Direct 
Convert workflow transcodes the Pass 1 mezzanine TIFO file into the final re-timed output.
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Tempo Ingest Workflow
The primary purpose of the ingest workflow is to create the requisite proxy and 
keyframe thumbnail versions of the original media and to register a binder containing 
the original media, proxy, and thumbnail into the appropriate catalog. 

Registering into a catalog is required in order for the Tempo Portal to access the media. 
A Tempo Portal configuration created in the Vantage Management Console > Workflow 
Portal panel is also required to make the catalog available to the Tempo Portal.

An optional Analyze action with Scene Detection Analysis selected for segment 
detection may also be used in the ingest workflow. This provides automatic scene 
detection and presentation on the timeline when the catalog and binder are selected 
in the Tempo Portal.
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Tempo Single Pass Workflow
The Tempo Single Pass workflow, accepts the previously ingested media file and re-
timing input parameters (via an automatically generated CML file) from the Tempo 
Portal. It then performs re-timing based on the CML, and generates an output (or 
outputs) in the format desired.

In the example below, the Receive action creates a Tempo Media Properties label that 
populates variables with details describing the ingested media file (in this case, 
progressive, top field first, or bottom field first). Decide actions branch the media 
processing depending on the media characteristics. Only one output from the Decide 
actions gets used. That output passes through a Tempo action for re-timing according 
to the instructions in the CML file received from the Tempo Portal. The Flip action then 
transcodes the re-timed file into the desired final output format.

Note that the branching used in the example is not required. The simplest single pass 
workflow only needs to contain a Receive action, and Tempo action, and a Flip action, 
and even the Flip action is not required if you can use the Tempo TIFO output directly.
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Tempo Pass 1 Workflow
The Tempo Pass 1 workflow represents the first stage of re-timing processing in a Two 
Pass scenario. The Pass 1 workflow receives input from the Tempo portal after ingest. 
The portal operator selects the media and re-timing parameters and submits them to 
the Pass 1 workflow using the Forward to Workflow panel. (Re-timing instructions are 
contained in an automatically generated CML file that the portal sends to the workflow 
during submission.)

 The Tempo actions in Pass 1 re-time the video and produce a TIFO file with the 
nickname Tempo Intermediary. This TIFO file is later submitted by the Tempo Portal 
operator, to the Pass 2 workflow for a second re-timing pass. Additionally, the Tempo 
action produces a Tempo Quality Report (CML file) that describes the media, including 
any artifacts where re-timing quality is lower than the Quality Threshold.

An Analyze action in Pass 1 detects scene changes in the media and generates an 
Analysis Result attachment, which is read by the Tempo Portal to automatically show 
scene changes on the timeline. 

A Flip action produces a re-timed proxy file, and a second optional Flip action (not 
shown) can be used to produce a thumbnail file for displaying a binder icon in the 
portal. 

A Register action registers the re-timed media, proxy, thumbnail, Analysis Report, and 
Tempo Quality Report into a catalog, which can be accessed from the Tempo Portal.

The behavior of the Tempo Portal in the next stage is driven by the Tempo Quality 
Report. The new proxy helps operators analyze the re-timed material to recognize areas 
where re-timing does not work well. The operator then uses the portal to mark areas of 
exclusion (areas that re-timing should not touch) in the second pass.



Tempo Workflows
Tempo Two Pass Re-timing Workflows

96

Tempo Pass 2 Workflow
The Tempo Pass 2 workflow represents the final stage in a Tempo Two Pass scenario. To 
utilize this workflow, the operator must have used the initial re-timed files in the Pass 2 
catalog/binder generated by the Pass 1 workflow, and marked scenes from that binder 
to exclude selected scenes found not suitable for re-timing by Pass 1. 

In this workflow, the Receive action automatically receives these files from the Tempo 
Portal when the operator selects this workflow in the Forward to Workflow panel:

• CML—the original CML generated by the portal for Pass 1 re-timing

• Exclusion CML—the CML indicating scenes to leave untouched during re-timing.

The final Tempo action re-times the output media a final time, producing the higher 
quality output desired of a Two Pass workflow. The original CML describes the media 
and the initial re-timing instructions. Scenes that the operator marked for exclusion in 
the Tempo Portal are listed in the Exclusion CML. This CML instructs the Tempo action 
which scenes not to include in re-timing to prevent quality issues. The Tempo action 
uses both CMLs to produce the second pass re-timed output in whatever format you 
selected in the Tempo Transcoder and Output selections.

Note that the above workflow is the simplest possible form. You can elaborate on this 
workflow as needed. For example, you can use Populate, Decide, and multiple Tempo 
actions, as in the Single Pass Workflow described earlier, to detect different aspects of 
the video and branch the workflow accordingly. 
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